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Preface 
The aim of this user guide is to help with the preparation of a review within the Cochrane 
Collaboration’s Review Manager software (RevMan). The user guide does not attempt to explain 
the methodological decisions you will need to make during your review. A detailed description of 
how to prepare and maintain systematic reviews can be found in the Cochrane Reviewers’ 
Handbook, with which you should be familiar and refer to when necessary. A basic knowledge of 
how to work a Microsoft Windows based program is assumed. If you have not used Windows 
before, or require any further information about it, please refer to a Windows user guide. For 
specific information about the RevMan interface, please refer to section 3 'Tree view'.  

! To alert yourself to possible pitfalls, it is helpful to read the user guide quickly before starting to 
use the program, paying particular attention to the notes marked !. 

! An on-line help system has been built into RevMan. If you press the F1 key you will get help 
on the section you are in. 

Acknowledgements 
Thanks to Carl Counsell, Lelia Duley, Monica Fischer, Jini Hetherington, Andy Oxman and 
Lindsay Reynolds for their invaluable help in preparing the user guide for RevMan 3.0 which was 
used extensively in preparing the new user guide for RevMan 4. 

Thanks to Jon Deeks for preparing the appendix on statistical methods used in RevMan Analyses. 

Thanks to members of the RevMan Advisory Group for their help in providing advice on the 
development of RevMan, and to all those who participated in beta-testing the successive versions 
of RevMan 4. 

Feedback 
If you have suggestions for how to improve RevMan, or this user guide, please send these to The 
Nordic Cochrane Centre via e-mail: revman-techsupport@cochrane.dk or fax: +45 35457007. 

Support 
For both technical and general support, an individual reviewer should first contact their 
Collaborative Review Group (CRG) co-ordinator. They will either direct the reviewer to an 
appropriate source of help within the CRG or, if necessary, will contact a Cochrane Centre or an 
appropriate Cochrane Methods Group. In general, Centres are not able to deal with direct queries 
from individual reviewers. Another option is to put questions on the RevMan discussion list on 
the Internet (see Appendix G), and wait and see what replies or suggestions appear. No support is 
available for people who are not members of CRGs. 

Another alternative is using the HTML Problem reporting form accessed through the Help menu 
for reporting technical problems directly to the programming team responsible for RevMan. The 
Help menu also provides access to a Wish List form for suggesting improvements to the software.  

Mike Clarke 
Rasmus Moustgaard 
Jacob Riis 

RevMan Documentation 
This document is part of the RevMan 4 documentation package, which contains a number of 
documents that each serves a particular purpose. Some information is reproduced in several of the 
documents, while other information can only be found in a single document. Most of the 
documents are available within RevMan. 
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Document: Description: 
RevMan User Guide Comprehensive task-oriented document, to be used in hard copy. Can 

be used for dedicated self-training. Overlaps with Help file. 
Accessed through Windows Start menu or in the RevMan installation 
folder. Available in MS Word and PDF format. 

RevMan Help file  Detailed descriptions of all windows and functions. To be used for 
looking up specific issues. Overlaps with User Guide. 
Accessed within RevMan through Help menu or F1 key. 

RevMan exercise Self-training package that in a few hours will lead you through the 
basics of preparing a Cochrane review in RevMan. 
Accessed within RevMan through Help menu. 

RevMan FAQ  Frequently asked questions about RevMan. Check here before 
requesting support. 
Available from:www.cochrane-net.org/revman/faq.htm 

Reviewers' Handbook  A complete guide to performing a Cochrane review. A printable 
version can be found on the RevMan CD-ROM or obtained from 
www.cochrane.org. 
Accessed within RevMan through Help menu. 

Style Guide  Guidelines on the style of Cochrane reviews. 
Accessed within RevMan though Help menu. 

RevMan exercise  A self-training exercise that goes through all the basic steps in 
creating a review. Does not cover advanced features. 
Accessed within RevMan though Help menu. 

Conventions used throughout this user guide 
• The Cochrane Collaboration’s Review Manager computer program is referred to as RevMan 
• Collaborative Review Group is referred to as CRG 
• The Cochrane Database of Systematic Reviews is referred to as the CDSR 
• ! indicates a special note, referring to the section directly above 
• Alt-S means that the Alt key should be pressed and held down while pressing S 

simultaneously 
• If you are asked to click a particular button, the label attached to the button is shown in italics  
• Labelled items in the software, such as buttons, windows or boxes are shown in italics (e.g. 

Add, Tree view or Review no). 



 

 

1 About Review Manager 
Review Manager (RevMan) is the Cochrane Collaboration’s program for preparing and 
maintaining Cochrane reviews. 

A Cochrane Review is a systematic, up-to-date summary of reliable evidence of the benefits and 
risks of healthcare. Cochrane Reviews are intended to help people making practical decisions. For 
a review to be called a ‘Cochrane Review’ it must be in the Parent Database, maintained by The 
Cochrane Collaboration. The Parent Database is composed of modules of reviews submitted by 
Collaborative Review Groups (CRGs) registered with The Cochrane Collaboration. The reviews 
contributed to one of the modules making up the Parent Database are refereed by the editorial 
team of the CRG. Reviewers adhere to guidelines published in the Cochrane Reviewers’ 
Handbook. The specific methods used in a Cochrane Review are described in the text of the 
review. Cochrane Reviews are prepared using RevMan, and adhere to a structured format that is 
described in the Cochrane Reviewers’ Handbook. 

RevMan allows you to enter protocols, as well as full reviews. It can perform meta-analysis of the 
data entered and present the results graphically. RevMan is designed through a continuing process 
of consultation with its users. 

RevMan is cited as: Review Manager (RevMan) [Computer program]. Version 4.2 for Windows. 
Oxford, England: The Cochrane Collaboration, 2002. 

RevMan Analyses is cited as: RevMan Analyses [Computer program]. Version 1.0 for Windows. 
In: Review Manager (RevMan) 4.2. Oxford, England: The Cochrane Collaboration, 2002. 

1.1 What's new in RevMan 4.2 

1.1.1 Images 
• Image files can be added to reviews as 'additional figures' (section 14). 

1.1.2 Text of review 
• Bold, italics, underline, subscript and superscript can be used (section 7.7) 
• More symbols (e.g. Greek letters) can be used (section 7.9) 
• It is possible to print a highlighted section only (Print button on Text of review screen) 
• Text marker can be used to highlight changes (the highlighting is not published) (section 7.8) 
• RTF files can be imported (section 7.5) 
• Delete and backspace can be used to delete a marked block of text that contains links 

1.1.3 Studies and references 
• Studies and references can be copied to other reviews (section 8.4, 9.5) 
• Tab key can be used in reference windows to change field 
• Classification pending references can be moved to studies in blocks (section 9.5.1) 
• Studies can be imported with attached references, e.g. from Meerkat (section 8.6) 
• References can be imported to an existing study or directly into 'Additional references' or 

'Other versions' (section 9.3.3) 
• Pick list can be used for recurring journal names (right click in SO: field) 
• The required fields are highlighted in references (section 9.3.1, 9.3.2) 
• Exporting of references can be restricted to specified sections (section 9.7) 
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• Citations can be copied to clipboard (button on Reference screen) 

1.1.4 Tables 
• Improved printing of additional tables and 'other data' tables 
• Rows and columns can be inserted and deleted in additional tables (section 12.1, 12.2) 
• Spell checking of entire tables (rather than cell by cell) (section 16.2.3) 
• Split bar in characteristics of ... studies tables (see online help) 
• Single study view for characteristics of included studies (section 8.1.1) 
• Additional tables can be copied to other reviews (section 12.3) 

1.1.5 Data and analyses 
• Comparisons and outcomes can be copied to other reviews (section 10.2.1) 
• Generic inverse variance method has been added (section 11.1) 
• New RevMan Analyses program (replaces MetaView) (section 13) 
• Multiple graphs can be printed on the same page (section 13.8) 
• Analysis graphs can be printed from RevMan (section 16.1.5) 
• Sets of multiple graphs can be exported in bitmap or vector formats (section 13.5) 
• Graphs can be copied to the clipboard (section 13.5.2) 
• Graphs can be saved as RTF files (section 13.5.4) 
• Funnel plots can be inserted into reviews as additional figures (section 13.5, 14) 

1.1.6 Contact details 
• Highlighting of differences when importing contact details for a person already in RevMan 

(section 5.1.2) 
• Improved functionality for importing contact details from HIREx (section 5.1.2) 
• A complete list of contact details can be printed (section 16.1.8) 
• Contact details can be exported (section 5.1.1) 

1.1.7 Other 
• Improved functionality for exporting reviews (section 16.1.2) 
• Review checking now follows the same rules as in the Module Manager (ModMan) software 

used by CRGs (section 16.1.4) 
• New status window displays numbers of reviews, protocols, titles, etc. (section 16.1.9) 
• Automatic backup keeps up to three backup files 
• The database can be closed temporarily to allow ModMan to access it (by pressing F8) 
• The 'list of reviewers for citation' can be generated automatically 
• The list of amended sections is updated automatically 
• The title of the tree view window can be changed to distinguish between different copies of 

RevMan 
• RevMan exercise is included (can be accessed from the Help menu) 
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2 Running RevMan 4 for the first time 
The first time you run RevMan after a new installation, you will be prompted to enter your 
contact ID and name. These will become the default values for your copy of RevMan. 

Contact ID: This is a unique identifier for each reviewer within a CRG. It can be 
up to four characters in length and should be agreed with your CRG 
to ensure that it is unique for your group. If you are working on 
reviews for more than one CRG, it is best to try to agree to use the 
same Contact ID for each of them. 

First name: Type your first name and any middle names you wish to be shown in 
full. 

Last name: Type in your last name. 

 
Click OK to finish. 
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3 Tree view 
The main window in RevMan consists of the Tree view, the menu bar and the toolbar. In addition, 
you can open a number of different windows for entering information in the various sections of 
your reviews. The Tree view is a structured representation of your reviews and their content that 
also allows you to manipulate them. You can use it to see which reviews are currently in RevMan; 
access a particular section of a review for viewing or editing; and edit your review, by adding, 
moving, copying or deleting items. The Tree view window cannot be closed. 

 

The Tree View 

3.1  Structure of the Tree view 
The elements of the Tree view are called headings, subheadings and items. By default, the top 
heading in the Tree view is Reviews. Each review is shown as a subheading. Use Show Reviewers 
from the View menu to change the top heading to Reviewers (see section 16.4 ‘View’). All 
headings and items have an icon denoting their type. This allows you to, for example, easily 
distinguish between titles, protocols and full reviews. The icons used in RevMan are shown in 
Appendix A. 

3.2  Navigating in the Tree view 
Headings and subheadings in the Tree view will have a small square to their left, containing either 
a ‘+’ or a ‘-’ sign. A ‘+’ indicates that the heading is collapsed and can be expanded, while ‘-’ 
indicates an expanded heading. Collapsing and expanding is either done by clicking on the ‘+’ or 
‘-’ square, or by double-clicking on the heading itself. Single-clicking on a heading or item will 
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highlight it. Double clicking an item will allow you to Edit it. You can also navigate the Tree view 
using the keyboard (see Appendix C). 

3.3  Rearranging items in the Tree view 
You can use the drag and drop function or copy/cut and paste to copy or move items in the Tree 
view. 

To drag and drop an item:  

• Click the item and keep the mouse button down. 
• Move the mouse pointer to the insertion point (which becomes highlighted). This will copy the 

item, if you wish to move the item hold down the <shift> key during this procedure. (The 
mouse pointer will indicate the difference between copying and moving by displaying a small 
‘+’ sign when copying.) 

• Release the mouse button. 

! The correct insertion point for any item is always the heading it belongs under. For example, to 
exclude a study, drag it to the Excluded studies heading, not onto the other excluded studies. 

To copy (or move) by using the copy/cut and paste function: 

• Highlight the item you wish to copy or move. 
• Select Copy or Cut from the Edit menu on the menu bar, or click the copy or cut button. 
• Highlight the insertion point. 
• Select Paste from the Edit menu on the menu bar, or click the paste button. 

3.3.1 Right-click menus 
The quickest way of performing a task in RevMan is often by using right-click menus. Just click 
an item or heading in the Tree view with the right mouse button to open a menu with a selection 
of relevant options for that item. Right-click menus always list the options to Add, Edit and 
Delete, although they will be disabled for some items. 

3.4  The toolbar 
The toolbar contains buttons for commonly used menu options such as Print, Cut, Copy, Paste, 
Add, Edit and Delete, a pair of browse buttons and buttons for accessing the analysis program and 
the help file. 

The browse buttons allow you to move up and down in the Tree view, while viewing the window 
(if any) associated with the currently highlighted item. You can only browse through items at the 
same level of the Tree view, such as all reviews or all references. 

!  The browse buttons will not automatically save any changes made in a window before moving to 
the next. To keep the changes, click Save before proceeding. 
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4 Creating a review 
To create a new review, highlight Reviews and click Add on the toolbar. This will create a new 
review and open the Title window, which is part of the Cover sheet for the review.  

4.1  Cover sheet 
! Before setting up the cover sheet, check that the default values and contact details are correct (see 

sections 5 ‘Contact details’ and 16.2.5‘Settings’). 

4.1.1  Title 
Title: Review titles should be as clear and brief as possible, but this field can 

store up to 250 characters. For guidelines on titles for Cochrane 
reviews, see the Style Guide. 

Version: One version of each review must be marked as the primary version but 
your copy of RevMan can contain up to 99 other versions of the same 
review. All versions will share the same title but versions that are not 
primary have a version label attached. The primary version of a review 
is the one you send to your CRG for publication in the CDSR. 
Secondary versions can be used as working copies, for experimentation 
or when you want to save older versions of a review. To change a 
primary to a secondary version, remove the check mark from the box 
labelled Primary version and add a version label (e.g. ‘Old version: Nov 
1998’). To change a secondary to a primary version, make sure that a 
primary version does not already exist and check the box labelled 
Primary version. If you wish to create a new version of an existing 
review, copy the review (see section 3.3 'Rearranging items in the Tree 
view'). 

Review no: A four character code, which will be used by your CRG to keep track of
reviews. This is especially useful if a reviewer is the contact reviewer 
for more than one review. You should discuss the coding system to use 
with your CRG. 
Reviews are primarily identified by the Unique ID (see below) - the 
review number is for human identification.  

Unique ID: This number is used as every Cochrane review's unique identifier in 
RevMan. All versions of a review share the same Unique ID, which 
cannot be edited. As the Unique ID is linked to the title of the review, 
you will in most cases use the title for identifying a review. The Unique 
ID is generated when a review is created in RevMan. RevMan uses the 
Unique ID to identify and match reviews when reviews are imported. 

Status: Entries in RevMan can be ‘Title only’ (default), ‘Protocol’, or ‘Full 
review’.  To enter either a protocol or a full review, click the 
appropriate circle. For titles and protocols, the Date next stage expected
at the bottom of the screen must be entered. The status can be changed 
at a later time, for example from protocol to review. 
! Only protocols and full reviews are published in the CDSR. 

Date edited: This date is assigned automatically by RevMan each time a change is 
made, and cannot be edited. If the assigned date is incorrect, you need 
to adjust the system date under Date/Time in your Windows Control 



RevMan 4.2 User Guide 

7 

Panel. 
Date of last substantive 
update: 

The most recent date on which the review was updated in such a way 
that you recommend that previous readers of the review should look at 
the new version. This date cannot be edited here. It is entered and edited 
using the What’s new window. 

Date next stage 
expected: 

The date by which it is expected that a title will become a protocol or a 
protocol will become a full review. When a review changes status to 
full review, you will be prompted to check if you want to clear this 
date. A warning message will be displayed if the Date next stage 
expected is before the current date. 

4.1.2 Reviewers 
To open the Reviewers window, first double-click the review’s title to expand it. Then expand the 
Cover sheet heading, and double-click Reviewers.  

Contact reviewer: The main contact person for the review. Select from the list obtained by 
clicking on the arrow at the end of the box. Click Edit contacts to add, 
edit or delete contacts (see section 5 ‘Contact details’). See section 
16.2.5 ‘Settings’ for how to specify the default contact reviewer who 
will be applied to any new review in your copy of RevMan. 

Co-reviewers: Use the Add and Delete buttons to create a list of the people who are 
co-reviewers for this review. If a person is not on the list when you 
click Add, click Edit contacts to add, edit or delete contacts. Each co-
reviewer needs a Contact ID, which should be obtained from the CRG. 
Use the box titled List of reviewers for citation to enter the names of all 
relevant reviewers in the way they are to appear in the citation for the 
review. Use the format Last name Initial(s), without a prefix (e.g. Dr) or 
internal punctuation and with a comma between names (e.g. ‘Silagy C, 
Mant D, Fowler G, Lancaster T’). 
When the Generate button is clicked, RevMan will attempt to put 
together the list of reviewers for you in the right format. It may be 
necessary to edit the list afterwards, e.g. to reorder the names or to 
delete any initials that should not appear in the list. 

Contributions: Describe the contribution each reviewer has made to the review. 

4.1.3 Sources of support 
Two types of support for a review can be acknowledged: internal (provided by the institutions at 
which the review was produced), and external (provided by other institutions or funding bodies). 
Each Internal and each External source of support has a unique number (between 01 and 99). This 
is used for ordering in the Tree view and when the review is published in the CDSR. The name of 
the source of support (excluding country) should be entered. To save time, you can click the 
arrow at the end of the box to select from the list of sources of support which are already present 
in your copy of RevMan. Select the relevant country from the list obtained by clicking on the 
arrow. 

! If you would like two sources of support to change places, assign an unused number to one of 
them, move the other by changing its number, then, if necessary, change the number of the first. 

! If the country of the source of support is not available in the country pick list, choose OTHER and 
notify the co-ordinator of your CRG of the missing country. If the source of support does not fit 
easily under one country, choose TRANSNATIONAL, or EUROPEAN UNION if appropriate. 

You can move or copy sources of support between Internal and External, see section 3.3 
'Rearranging items in the Tree view'. 
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4.1.4 What’s new 
This published text field should be left empty until the protocol or full review has been published 
in the CDSR. Each time you send an updated version of the review to your CRG, make sure that 
this field describes the major changes that have been made. For example, you should describe 
briefly how much new information has been added to the review (e.g. number of studies, 
participants or extra analyses) and any important changes to the results of the review. If you wish 
to log all changes made to a review, the information in this field could be copied to the 
Unpublished CRG notes under Notes. 

The associated dates provide the reader of the review with information on when the review was 
last updated and why. You need to enter or edit all dates that are applicable but when you save 
changes to any part of a review, you will be prompted to register the change as a substantive 
update, a minor update or not register the change. If you choose one of the first two options the 
corresponding date on this window will be changed to the current date. If the assigned date is 
incorrect, you need to adjust the system date under Date/Time in your Windows Control Panel. 

Issue protocol first 
published: 

The issue of The Cochrane Library where the protocol was first 
published (e.g. Issue 1, 1999). 

Issue review first published: The issue of The Cochrane Library where the full review was first 
published (e.g. Issue 4, 1999). 

Date of last substantive 
update: 

The reviewer(s) and/or editors of a CRG should decide whether an 
update (amendment) is substantive or not. Substantive update are 
ones which are sufficient to recommend that previous readers of the 
review should look at the updated version. For example, important 
changes in the conclusions of the review or the list of studies that are 
included or excluded, may qualify as substantive updates. 

Date of last minor update: The most recent date on which the review was updated, but this 
update is not sufficient to recommend that previous readers of the 
review should look at the new version. 

Date review re-formatted: The most recent date on which structural changes were made to the 
review (e.g. as the result of the addition of a new fixed heading). 

Date new studies sought but 
none found: 

The most recent date on which a search was done for new studies 
but none were found. 

Date new studies found but 
not yet included or 
excluded: 

The most recent date on which a search was done for new studies 
and some were found and added to the tables of studies awaiting 
assessment or ongoing studies. 

Date new studies found and 
included or excluded: 

The most recent date on which studies were added to the list of 
included or excluded studies. 

Date reviewers’ conclusions 
section amended: 

The most recent date on which the Reviewers’ conclusions section 
was amended in such a way that you recommend that previous 
readers of the review should look at the new version. 

Date comment / criticism 
added: 

The most recent date on which a comment or criticism was added to 
the review. 

Date response to comment / 
criticism added: 

The most recent date on which a reply to a comment or criticism was 
added to the review. 

4.1.5 Notes 
Unpublished CRG notes: Text in this field can be printed within RevMan and is included in 

the export file, but it will not be published in the CDSR. These notes 
can be used for sending messages to your co-reviewers or editorial 
team. 
In view of the potential problems with tracking changes in reviews 
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as they are edited and updated, you may like to use this field for 
logging the changes that are made in a review. 

Published notes: This field will be published in the CDSR, and can be used for, for 
example, editorial notes. 

Amended sections: The purpose of the Amended sections boxes is to make it easier for 
your co-reviewers or editorial team to locate the latest changes you 
have made (this practise should be agreed by all involved). When a 
change is made the appropriate box a automatically checked, but you 
can also add/remove check marks manually. The information is not 
published in the CDSR. If you want information on changes to be 
published in the CDSR, this information should be entered in the 
What's new section (4.1.4). 

!  When you save a change you will be given the option to start on 
a new (empty) list of amended section. 

4.2 Deleting reviews 
To permanently delete a review or a version of a review, highlight the title in the Tree view and 
click the Delete button. You will be asked to confirm your action. To delete more than one review 
in one step, select the reviews to delete first (use the Select (+) button), then highlight the Reviews 
heading and click Delete. 

! It is not possible to undo the deletion of a review. If you have any doubt about whether a review 
should be deleted, export the review before deleting it. 
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5 Contact details 
A reviewer within RevMan has a single set of contact details, which will be used for all relevant 
reviews. 

The Contacts window can be accessed by choosing Contacts from the Edit menu or though the 
Reviewers section of the Cover sheet (see section 4.1.2 ‘Reviewers’). From here, you can select a 
name and click Edit to open the Contact details window. 

Alternatively, you may choose to structure the Tree view by reviewers by selecting Show 
Reviewers on the View menu, see section 16.4 ‘View’. Now you can go directly to Contact details 
by highlighting your name and clicking Edit. 

The information you enter in the Contact details window will not be saved until you click Save on 
the Contacts window. 

The contact details you enter into RevMan will be used in three ways: 

• by your CRG 
• in the cover sheet section of your reviews in the CDSR 
• to update the central email list of reviewers and co-reviewers 
The data may also be used to update the central Cochrane directory of names and addresses. 

 
Type the appropriate information into the labelled boxes. Leave the fields that are not applicable 
blank. You should check that your contact details are correct whenever you submit a new or 
updated review to your CRG.  

Contact ID: Your Contact ID is used to identify you within your CRG. It should be 
assigned by the CRG and only be changed by agreement with your CRG. 

Name: Enter your prefix from the list obtained by clicking on the arrow and 
selecting the appropriate option, or by typing it. Type your first name and 
any middle names you wish to be shown in full, initials for any middle 
names you do not wish to be shown in full, your last name and any suffix 
you wish to use into the boxes. You should also type in your position, 
department and organisation; and, if available, the name of someone who 
could be contacted if you are not available. 

Address: You can enter a primary and, if available, a secondary address. It is 
important that these addresses are complete and accurate. The primary 
address will be published in the CDSR. The secondary address will not 
be published in the CDSR but may be included in the central Cochrane 
directory of names and addresses unless you mark it as ‘private’. 
Addresses should be entered in the order commonly used in your country.
Select your country from the list obtained by clicking on the arrow. 

Telephone and fax: Use international format without hyphens (i.e. +[country code] [area 
code] [local number], e.g. +45 35 455571). 

Internet: Please use lower case letters for e-mail addresses. Multiple e-mail 
addresses should be separated by a semicolon and a space, e.g. 
'myname@cochrane.org; myname@hotmail.com', rather than using 'or', 
'and' or commas. 
If available, give the address of a relevant web site. 

Description: You can give a description of your role in the Cochrane Collaboration, 
such as CRG and Methods Group memberships. This will not be 
published in the CDSR. 
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5.1.1 Exporting contact details 
To export all contact details stored in your copy of RevMan to a text file in HIREx merge format: 

• Use Export / Contact details… from the File menu. 
• Specify a filename and location. 
• Click Save to export 

5.1.2 Importing contact details 
To import a set of contact details from a text file in HIREx merge format, select Import / Contact 
details… from the File menu, and then select the file you wish to open. 

Contact details are imported into a temporary buffer from which you can decide what to do about 
the individual people (import, not import, overwrite existing, create new). 

The contacts are shown in two panels. The panel on the left shows the imported contacts. The 
panel on the right shows the contacts already in RevMan. You can use the < and > buttons to 
browse through the contacts one by one. Use the << and >> buttons to jump to the beginning or 
end of the contact list. 

! Use Hide identical matches to only see the records where RevMan has detected a difference. 

When browsing though the imported contacts in the left panel, the right panel will automatically 
change to show any matching contact in RevMan (contacts are matched on Contact ID (primary) 
as wll as name and email (secondary)). You can override this selection by choosing another 
matching contact, or by creating a new contact (click Create new). 

You can choose not to import a contact by removing the check mark from Import record. If a 
match is found in RevMan, which has a later “Date edited”, the check mark for importing the new 
record will be removed by default, but can be added by clicking on the check box. 

When you are satisfied with the import options for all contacts, click Import. Clicking Cancel will 
close the window without importing any contacts. 
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6 Constructing and editing a review 
The first step in preparing a review is to develop a protocol (including text describing the 
background, objectives, criteria, search strategy, and methods), using the guidelines described in 
the Cochrane Reviewers’ Handbook. The protocol should be entered into RevMan under Text of 
review (see section 7) with any references used being entered under Additional references (see 
section 9.2). When the information required for the full review is ready, the next step is to 
complete the review within RevMan. Included and excluded studies must be added along with 
references if available, followed by descriptive details of these studies. If appropriate, a list of the 
comparisons that are going to be made and the associated statistical data can be entered. The text 
of the review can then be completed. 

! Plan each review carefully and prepare as much of the information as possible before entering 
anything into RevMan. For example, extract data from the trials onto prepared paper forms, rather 
than entering them directly into RevMan (this facilitates double data entry and checking, and 
provides a permanent record). 

! Warning! When updating your review, you may wish to split it into two or more separate reviews. 
It is important to consult your CRG before doing this. Your CRG can help by creating two 
identical copies of the review that have different titles and their own unique IDs. You cannot do 
this using the review copy function in RevMan. 

6.1  Synopses 
The synopsis is a brief summary of the results of the review in plain language for consumers and 
non-specialist readers. The synopsis has two parts: a short, single sentence 'headline' of up to 25 
words (in lower case apart from the first letter of the first word); followed by a single paragraph 
summary of the context and findings of the review (50 to 100 words). The heading and the 
paragraph should be separated by a blank line. In order to keep the 'headline' short, some 
abbreviations and technical terms may be inevitable. However, these should be expressed in plain 
language in the body of the synopsis (with either the technical or simple description in 
parentheses). For information about preparing synopses, see the Handbook Appendix 2a.2. 
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7 Entering the text of a protocol or review 
The Text of review window is where you enter and edit the core text of a review. This has pre-
defined headings under which the text must be entered. These headings are fixed for all Cochrane 
reviews and cannot be deleted or modified. You can use bulleted lists, bold, italics and underline 
(see below) but the text cannot contain any other special formatting (e.g. tables, text justification, 
tabs, different fonts). You should only use standard ASCII characters and the special characters 
supported by RevMan (see Appendix H), which can be inserted using the Insert symbol button 
(see below). Any other characters might not appear correctly when the review is published in the 
CDSR. 

RevMan is not meant to be a sophisticated word processing program. You may prefer to prepare 
your text in a word processor and then bring the whole text into RevMan (see section 7.2 ‘Text of 
a review’), but this does not give you more options for formatting the text when it is within 
RevMan. 

7.1  Text of a protocol 
A Cochrane review is planned by developing a protocol. The protocol should include only the 
background of the review, its objectives, inclusion and exclusion criteria for the trials, search 
strategy for identifying trials, methods, and appropriate references. Guidelines for preparing 
protocols are in the Cochrane Reviewers’ Handbook, which should be referred to in the 
preparation of all Cochrane reviews. The text of a protocol (which is, in fact, the text of the 
review up to the end of the methods section) can be entered into RevMan in three way, as 
described below. 

7.2  Text of a review 
When the protocol, and details of the relevant studies (including data if appropriate) have been 
entered into RevMan, the text for the remaining headings under Text of review (including the 
synopsis and abstract) should be finalised in RevMan. The synopsis should be prepared in 
accordance with the policy of your CRG. For example, it might be written by you, by someone 
else in your CRG or by others on your behalf. 

Text can be entered into RevMan in three ways: typed in directly, prepared in a word processing 
package and pasted into the appropriate place, or imported as a RTF or plain text file containing 
the proper headings for the Text of review section.  

7.3  Typing in text 
To type in text: 

• Highlight Text of review and click Edit. This will open the Text of review window, which 
contains fixed headings for each section. To go directly to a particular text section, expand Text 
of review and Edit the relevant section. 

• Type in the text. 
• When you have finished, click Save and then Close. If you click Close without saving, you 

will be asked if you want to save the changes before exiting. If you answer No the changes to 
the text will be lost. 

! If two fixed headings become ‘stuck together’, Save the text to insert a blank line between them. 

! There may be a noticeable delay when typing in the Text of review section for reviews with 
approximately 5000 words or more of text. This delay increases with the amount of text. If you 
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have a large amount of text to type, you can open a Quick edit window by pressing Ctrl-Q. You 
will not experience these delays when working in the Quick edit window, but you will also not 
have any of the added functionality of the Text of review window, such as bulleted lists and other 
formatting, link handling, find and replace etc. 

7.4  Pasting in text 
To cut and paste text from a Windows-based word processing package: 

• Highlight Text of review and click Edit, which will open the Text of review window, which 
contains fixed headings for each section. To go directly to a particular text section, expand Text 
of review and Edit the relevant section. 

• Open the previously prepared text file in your word processor. 
• Mark and copy a section of text, excluding the heading (if you have used headings in your 

word processor document). 
• Return to RevMan, place the cursor below the relevant heading, and Paste the text. 
• Repeat the above for each relevant section. 
• When you have finished, click Save and then Close. If you click Close without saving, you 

will be asked if you want to save the changes before exiting. If you answer No the changes to 
the text will be lost. 

! Any formatting that you added within the word processor is removed when text is pasted into the 
Text of review window and any special symbols, such as α or β, are converted to the standard 
character set. This is necessary to ensure that only formatting which complies with the agreed 
Cochrane review format is used. Any formatting or special symbols that you previously had in the 
pasted text can be re-applied within RevMan (see sections 7.6 to 7.9).  

7.5  Importing text 
To import text from a Windows-based word processing package: 

• Create a document containing only the fixed headings by saving the text of an empty review 
using File / Export / Text of review / RTF. 

• Use this document as a template within your word processor for writing the text. 
• Save the document as a RTF or plain text file. 
• Return to RevMan and use File / Import / Text of review to bring the text into RevMan. You 

will be asked to confirm that you understand that importing text will overwrite any text already 
in the Text of review section. 

• Choose between text files and RTF format under Files of type. 
• Select the file to import and click OK 

! RevMan will not prevent you from importing files that are not in the proper format, but the 
resulting text will be corrupted. 

! If you have used bold, italic, underline, subscript or superscript in your word processor, use the 
RTF format when transferring the text to RevMan. The import functions will try to preserve as 
much formatting as possible (the success depends on which word processor you used). Special 
characters (e.g. from the Symbol font) will not be transferred correctly, so these must be inserted 
within RevMan. If the text of the review looks strange after importing (e.g. if all the text has been 
imported into a single section) check that no changes were made to the headings (for example, an 
added full stop will break the import mechanism). If you have no success using RTF format, 
please try the plain text option instead. This will not preserve any formatting, but should work 
with any word processor. 
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7.6  Bulleted lists 
Click the bulleted lists button to start a new bulleted list. Separate each point in the list with hard 
returns. To stop entering bullet points click the button again. The button can also be used to turn 
highlighted text into a bulleted list (each line ending with a hard return will become a bullet point) 
or to turn a highlighted bulleted list into plain text. 

The bulleted lists in RevMan can only have a single level, i.e. you cannot create sub-lists. 

7.7  Text formatting 
Cochrane reviews can contain the following types of text formatting: bold, italic, underline, 
superscript and subscript. Use the buttons (B, I, U, x², x2) to toggle the associated formatting style 
on/off when typing new text or for highlighted text. 

7.8  Text marker 
Text sections can be highlighted in red to draw attention to them when writing or editing the 
review. 

Use the  button to toggle text marking on/off when typing new text or for highlighted text. 

! Text marking will be included when you export reviews, but it will not be published in the CDSR. 

7.9  Inserting symbols 
To insert one of the symbols supported in Cochrane Reviews: 

• Place the cursor at the point in the text where the symbol should be inserted. (If you highlight 
a section of text the symbol will replace it.) 

• Click the Insert symbol (α) button. 
• Highlight the symbol you wish to insert. 
• Click OK. 

7.10 Inserting references 
To insert a hypertext link to a reference (see section 9 ‘References’), select the reference from the 
list obtained by clicking on the arrow at the end of the box next to the Insert link to: button 
(references to studies are listed first under the appropriate headings, then other references), move 
the cursor to the place in the text where the link should be inserted and click Insert link to:. The 
link will be shown in the text as the study or reference ID in blue. You will need to add 
appropriate punctuation: namely, surround the ID with parentheses and separate any IDs that are 
inserted at the same place with semicolons (e.g. (Abelin 1989; TNSG 1991)). You cannot edit the 
link but it will be automatically updated if the relevant study or reference ID is changed. To delete 
a link to a reference, place the cursor within the relevant link and click the Delete link button.  

! Links are not active in RevMan (i.e. you do not jump to the target for a link by clicking on it). 
The links are made active when the review is published in the CDSR or when you export the 
review as HTML. 

Because the text of links is protected from any kind of editing you may have to use the Remove 
links function (see 7.14) before applying formatting to or cutting out a section of text containing 
links. 

7.11 Inserting links to Additional tables 
You cannot create tables directly in the Text of Review, instead you can create Additional tables 



RevMan 4.2 User Guide 

16 

that can be linked to from the text (see section 12 ‘Additional tables’). 

To insert a hypertext link to an Additional table, select the table from the list obtained by clicking 
on the arrow at the end of the box next to the Insert link to: button (additional tables can be found 
near the end of the list), then move the cursor to the place in the text where the link should be 
inserted and click Insert link to:. The link will be shown in the text as ‘Table X’ in blue where X 
is the table number. You cannot edit the link but it will be automatically updated if the relevant 
table number is changed. To delete a link to an Additional table, place the cursor within the 
relevant link and click the Delete link button. 

! Links are not active in RevMan (i.e. you do not jump to the target for a link by clicking on it). 
The links are made active when the review is published in the CDSR or when you export the 
review as HTML. 

7.12 Inserting links to Additional figures 
You cannot insert images directly in the Text of Review, instead you can include Additional 
figures that can be linked to from the text (see section 14 ‘Additional figures’). 

To insert a hypertext link to an Additional figure, select the figure from the list obtained by 
clicking on the arrow at the end of the box next to the Insert link to: button (Additional figures 
can be found at the end of the list), then move the cursor to the place in the text where the link 
should be inserted and click Insert link to:. The link will be shown in the text as the figure ID  in 
blue. You cannot edit the link but it will be automatically updated if the relevant figure ID is 
changed. To delete a link to an Additional figure, place the cursor within the relevant link and 
click the Delete link button. 

! Links are not active in RevMan (i.e. you do not jump to the target for a link by clicking on it). 
The links are made active when the review is published in the CDSR or when you export the 
review as HTML. 

! It is not possible to add links to the Characteristics of studies tables or analyses in the comparisons 
table. These links will be inserted automatically under the appropriate headings when the review 
is published in the CDSR. 

7.13 Find links 
To search a section of text for links to all of the studies, references, Additional tables or 
Additional figures currently in the review, highlight the section and click Find links. This is useful 
if you have pasted text containing links, as they will then have been removed. 

7.14 Remove links 
To clear all links from a section of text, highlight the section and click Remove links. Only the 
link status will be removed – not the text of the link. You will need to do this to enable you to cut 
text that contains links. Use Find links to restore the link status. 
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8 Studies 
RevMan distinguishes between studies and references. A study represents a physical experiment 
(e.g. a randomised controlled trial) while a reference represents the description of the study (e.g. a 
journal article). Each study can contain multiple references. 

RevMan divides studies into four categories: 

Included studies: Studies that meet the inclusion criteria for your review. 

Excluded studies: Studies that were considered for your review but do not meet 
the inclusion criteria. 

Ongoing studies: Studies that are likely to meet the inclusion criteria for this 
review but are not yet completed. 

Awaiting assessment: Studies for which further information is needed before you can 
decide whether to include it. This is a temporary status, and 
studies should be moved from here as soon as possible. 

 
See the Cochrane Reviewers’ Handbook for a more comprehensive discussion about study 
identification, inclusion and exclusion. 

Studies are added through the References or the Tables sections of RevMan (see ‘Adding study 
details’ below).  They can also be imported from a file of references that include the study name 
(SN:) tag (see section 8.6 ‘Importing studies’). 

8.1  Adding study details 
To add a new study in the References section: 

• Highlight the heading that the study belongs under (e.g. Included studies). 
• Click Add to open a study window. 
• Type in the information noted below. 
• Click OK. 

 
To add a new study in the Tables section: 

• Highlight the table the study belongs in (e.g. Characteristics of included studies). 
• Click Edit to open the table window.  
• Click Add study to open a study window. 
• Type in the information noted below. 
• Click OK. 

 
Study ID: This is an identifier (maximum 20 characters) for the study, which must be 

unique within the review. It is used throughout the review and for linking to 
from the text. The identifier is usually formed from the surname of the first 
author, the location of the study or the name of the study group along with the 
year of publication of the main results (e.g. Abelin 1989 or TNSG 1991). Add a 
trailing letter to distinguish between studies that would otherwise have identical 
Study IDs (e.g. Abelin 1989a and Abelin 1989b). 

Year: The year to be associated with this study. Enter the year here even if it is 
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included in the Study ID and try to be consistent in how the year to input is 
chosen for each study within your review (e.g. year that the study began or year 
of publication). 
! You must enter a year in this field if it is to be used to sort studies in the 
analysis section. If studies are from the same year, add a trailing letter to 
achieve a particular sort order within that year (e.g. 1995a will appear before 
1995b). 

Data source: This can be either published data only, published and unpublished data, 
unpublished data only or unpublished data sought but not used. 

8.1.1 Included studies 
Use the Characteristics of included studies table to show details of the included studies. The table 
has seven columns: Study ID, Methods, Participants, Interventions, Outcomes, Notes and 
Allocation concealment. Use footnotes for, for example, explanations of any abbreviations used 
(these will be published in the CDSR). 

! You can choose between Table view and Single study view, depending on your preference. 

Study ID: Study ID cannot be edited in this table. To edit Study ID, highlight the study 
under Included studies in the Tree view and then Edit it. 

Methods: Information about methods that might be presented here includes: study 
duration; type of trial (such as parallel or cross-over design); patient, provider 
and outcome assessor blinding; amount of drop-outs and cross-overs; co-
interventions and other potential confounders. Assessments of the validity of 
each study using explicit criteria (as described in the text under ‘Methods’) 
should be reported here.  

Participants: Describe the inclusion/exclusion criteria for the study and any other relevant 
characteristics such as setting, number of participants, age, sex, and disease 
stage. 

Interventions: Describe the forms of health care that were compared (including placebo if 
appropriate). Where relevant, give details such as dose and duration of therapy.

Outcomes: List the outcomes measured in the study. If applicable, differentiate between 
those that are analysed in the review and those that are not. 

Notes: Include any other information that might be useful to the reader. This 
information will be published in the CDSR. 

Allocation 
concealment: 

Refers to a score for how well the allocation to intervention groups was 
concealed. This score is study (rather than outcome) specific so it is entered 
here. Use A, B, C to indicate quality of concealment, and D if this score has not 
been assigned. For further details refer to the Cochrane Reviewers’ Handbook, 
but in summary: 
A indicates adequate concealment of the allocation (e.g. by telephone 
randomisation, or use of consecutively numbered, sealed, opaque envelopes). 
B indicates uncertainty about whether the allocation was adequately concealed 
(e.g. where the method of concealment is not known). 
C indicates that the allocation was definitely not adequately concealed (e.g. 
open random number lists or quasi-randomisation such as alternate days, 
odd/even date of birth, or hospital number). 
D indicates the score was not assigned. 

 
See Appendix B 'Using Tables' for help on resizing columns and rows. 
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8.1.2 Excluded studies 
Use the Characteristics of excluded studies table to show your reasons for excluding each study. 
The table has two columns: Study ID and Reason for exclusion. Use footnotes for, for example, 
explanations of any abbreviations used (these will be published in the CDSR). 

Study ID: Study ID cannot be edited in this table. To edit Study ID, highlight the 
study under excluded studies in the Tree view and then Edit it. 

Reason for exclusion: State the reason for excluding the study. 
 

See Appendix B 'Using Tables' for help on resizing columns and rows. 

8.1.3 Ongoing studies 
Use the Characteristics of ongoing studies table to show details of any ongoing studies. The table 
has seven columns: Study ID, Trial name or title, Participants, Interventions, Outcomes, Starting 
date, Contact info and Notes. Use footnotes for, for example, explanations of any abbreviations 
used (these will be published in the CDSR). 

Study ID: Study ID cannot be edited in this table. To edit Study ID, highlight the 
study under Ongoing studies in the Tree view and then Edit it. 

Trial name or title: Give the name or title by which the study is usually known. 
Participants: Describe the inclusion/exclusion criteria for the study and any other 

relevant characteristics such as setting, number of participants, age, sex, 
and disease stage. 

Interventions: Describe the forms of health care that were compared (including placebo 
if appropriate). Where relevant, give details such as dose and duration of 
therapy. 

Outcomes: List the outcomes measured in the study. 
Starting date: Give the starting date, if known. 
Contact information: Give the contact information for the study, if appropriate (remember that 

this information will be published in the CDSR). 
Notes: Include any other information that might be useful to the reader. This 

information will be published in the CDSR. 
 

See Appendix B 'Using Tables' for help on resizing columns and rows. 

8.2  Editing study details 
Study ID, Year and Data source are edited in the References section. To edit one of these: 

• Highlight the study in the relevant References section. 
• Click Edit to open the study window. 
• Edit the information as necessary. 
• Click OK. 

 
Other characteristics of the study are edited in the Tables section. To edit these: 

• Highlight the table the study belongs in (e.g. Characteristics of included studies). 
• Click Edit to open the table window.  
• Edit the information as necessary. 
• Click Save, then Close. 
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8.3  Moving a study to another section 
Studies can be moved between sections by using the drag and drop function, the Cut and Paste 
functions or the right-click menu. 

To drag and drop a study:  

• Click the study and keep the mouse button down. 
• Hold down the <shift> key and move the mouse pointer to the insertion point (which becomes 

highlighted). 

• Release the mouse button. 
To move a study by using the cut and paste function: 

• Highlight the study you wish to move. 
• Select Cut from the Edit menu on the menu bar, or click the cut button. 
• Highlight the section to which the study is to be moved. 
• Select Paste from the Edit menu on the menu bar, or click the paste button. 

! Warning! When you move a study to another section its references will remain attached to it, but 
all its information in the relevant Characteristics of studies table and data tables will be deleted. 
(You will be prompted to confirm that this is okay before completing the move). If you do not 
want this to be deleted you should enter the study in the new section and move the related 
information using cut and paste. 

8.4  Copying studies to other reviews 
It is possible to copy studies to other reviews using drag and drop or copy and paste. References 
will be copied along with the study, and if a study is copied to the same section (e.g. included to 
included) its characteristics are also copied to the relevant Characteristics of studies table. 

8.5  Deleting a study 
To delete a study: 

• Highlight the study in the relevant References section. 
• Click Delete, you will be asked if you really want to delete the study. 
• Click Yes to confirm deletion, or No to cancel. 

! Warning! When a study is deleted, all its references and any information about it in the relevant 
Characteristics of studies table and data tables will be lost. If links to the study in the text exist, 
the links will be converted to plain text. 

8.6  Importing studies 
It is possible to combine the import of references and creation of studies into one step. The 
requirement is that each reference in the tagged reference file contains an extra SN: (study name) 
tag with the name of the study. This type of file can, for example, be created from specialised 
register software such as Meerkat, or the study name tags can be added in a text editor. 

To import studies from a file with tagged text references: 

• The import file must have one field on each line, an empty line between references and each 
reference must include the SN: tag. For a list of fields and tags, see Appendix E. 

• Highlight the relevant review. 
• Use Import /Studies... from the File menu. 
• Select the file to import, and click OK 
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! If a study identified through the study name tag already exists, RevMan will add the reference to 
that study. If no study exists, a new study will be created under Studies awaiting assessment and 
the reference will be added to that study. More than one reference can be imported for a study in a 
single import step. Any references without a study name tag will not be imported.  
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9 References 
RevMan stores information on references in a structured format to allow easier importing and 
exporting of references by using tagged fields. References are stored in two main sections: 
References to studies and Other references. 

9.1  References to studies 
A study can have several references, one of which can be selected as the primary reference. A 
primary reference will be represented by a bold icon in the Tree view. Information on adding and 
manipulating references to studies in RevMan is given below. 

9.2  Other references 
Three other types of reference than references to studies are stored in RevMan: Additional 
references, Other published versions of this review and Classification pending. Information on 
adding and manipulating references to studies in RevMan is given below. 

Additional: References referred to in the text of the review. 
! To cite a particular reference for a study with more than one reference, 

you should copy the relevant reference to Additional references. 
Other published 
versions of this 
review: 

All other published versions of the review. These will appear in alphabetic 
order sorted by Reference ID. Earlier versions of the review which were 
published in the CDSR and which have been substantially updated should 
be included. You might like to use the Reference ID to arrange these 
references in chronological order, with the most recent at the top. It might 
also be helpful to group together the references to earlier versions 
published in the CDSR. This can be done using the Reference ID by, for 
example, beginning the ID with ‘CDSR’. 

Classification 
pending: 

A temporary category used for imported references only. These are not 
published in the CDSR. 

9.3  Adding references 
For both References to studies and Other references, references can be entered either by typing in 
or by importing from files which can be generated by standard bibliographic software (e.g. 
ProCite or Reference Manager, see appendix F). All newly included and excluded studies will 
automatically be assigned an empty reference. 

! You have a choice of several methods when adding studies and references to your review, which 
can also be combined. One way is simply typing all the information directly in to RevMan. 
Another option is to enter all the studies manually, import a file with all references for the review 
into the Classification pending section, and then move them to the appropriate studies. A third 
option is to import and create the studies in one step (see 8.6). The section below describes the 
various options. 

9.3.1 Typing in References to studies 
• Highlight the relevant study then click Add. 
• Select whether or not this is the primary reference for the study.  
• Choose a reference type. This is not published, but it selects which fields are suggested and 

how the citation will be formatted. 
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• Enter information next to the appropriate field names. See Appendix E for more information 
on how to store information on different types of reference. When a reference type is selected, 
some of the field names are displayed in bold. These are required fields for that reference type 
and if left blank will trigger a warning when the review is checked for errors. The fields that 
will not be included in the associated citation will be greyed out. You can still enter 
information into these fields, but this information will not be included in the citation. The 
remaining fields in normal font are optional and will only be included in the citation if they 
contain text. 

• If necessary, click View citation to display the formatted citation for the reference.  
• When you have finished, click Save and then Close. If you click Close without saving, you 

will be asked if you want to save the changes before exiting. If you answer No the changes to 
the text will be lost. 

9.3.2 Typing in Other references 
• Highlight the relevant heading then click Add. 
• Type in the Reference ID. 
• Select whether or not this is the primary reference for the study. 
• Choose a reference type. This is not published, but it selects which fields are suggested and 

how the citation will be formatted. 
• Enter information next to the appropriate field names. See Appendix E for more information 

on how to store information on different types of reference. When a reference type is selected, 
some of the field names are displayed in bold. These are required fields for that reference type 
and if left blank will trigger a warning when the review is checked for errors. The fields that 
will not be included in the associated citation will be greyed out. You can still enter 
information into these fields, but this information will not be included in the citation. The 
remaining fields in normal font are optional and will only be included in the citation if they 
contain text. 

• If necessary, click View citation to display the formatted citation for the reference.  

• When you have finished, click Save and then Close. If you click Close without saving, you 
will be asked if you want to save the changes before exiting. If you answer No the changes to 
the text will be lost. 

9.3.3 Importing references 
RevMan can only import references from plain text files that contain either tagged text references 
or references formatted in the Vancouver style. All references in the file will be imported into one 
of four possible sections: as references to a single study, or into the Additional references, Other 
published versions of this review or Classification pending section of Other references. 
References imported into Classification pending can later be moved to the relevant sections in the 
Tree view (see section 9.5 'Moving references').  

To import from a file with tagged text references: 

• The import file must have one field on each line and an empty line between references. For a 
list of fields and tags, see Appendix E. 

• Highlight the relevant review. 
• Use Import / References / Tagged text format... from the File menu. 
• Select the section to import to (for Existing studies, also select the relevant study from the list), 

and click OK.  
• Select the file to import, and click OK. 

! References exported from The Cochrane Library are directly compatible with RevMan. To create 
compatible files from reference management software like ProCite or Reference Manager, you 
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need to generate a bibliography using a special output style. Three sample output styles, 
‘revman.pos’ for ProCite 4.0 ‘revman.os’ for Reference Manager 8.5 and 'revman.ens' for 
EndNote are located in the RevMan installation directory (see appendix F). 

To import from a file with references formatted in the Vancouver style: 

• The import file must have one reference on each line. Empty lines are ignored. RevMan 
attempts to split the formatted references into the fields of the structured format during import. 
This works best if the references are in Vancouver style for a journal article (i.e. Author1, 
Author2. Title. Journal Year; Volume(Issue):firstpage-lastpage.). 

• Highlight the relevant review. 
• Use Import / References / Vancouver format... from the File menu. 
•  Select the section to import to (for Existing studies, also select the relevant study from the list) 

and click OK. 
• Select the file to import and click OK. 
• The original reference will be kept in the Unpublished notes field of the reference in RevMan, 

enabling you to check if it was imported correctly. 

! All references imported into Classification pending must be moved to the appropriate sections 
under References to studies or Other references. Classification pending is a temporary category, 
and will not appear in the CDSR. 

9.4  Editing references 
To edit a reference: 

• Highlight the reference. 
• Click Edit to open the reference window. 
• Edit the information as necessary. 
• Click Save, then Close. 

9.5  Moving references 
A reference can be copied or moved from the Classification pending section using the right-click 
menu, the drag and drop function or the Copy (or Cut) and Paste functions. You can copy or move 
references from a section under Other references to another sections under Other references, a 
sub-heading to References to studies (creating a new study with the reference) or to an existing 
study (adding a reference to the study). You can also copy or move references from studies to 
Other references. You cannot copy or move references directly between studies. 

! Choosing the easiest way of handling references imported into Classification pending depends on 
whether you have already created studies. Adding the studies first might be most efficient if you 
have more than one reference per study. If you only have a single reference per study, you may 
find it easier to have RevMan create the studies when you move the references. 

9.5.1 Using the right-click menu to move references 
To move or copy a reference to an existing study using the right-click menu: 

• Right-click the reference. 
• Move the cursor to Move reference to or Copy reference to as appropriate. 
• Select the section you wish to move or copy the reference to. 

! If you move or copy a reference to one of the sections under References to studies, a new study 
will automatically be created, using the Reference ID as the Study ID.  
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If you need to move several references from Classification pending to existing 
studies, right click one of the references and choose Move reference(s) to study 
from the menu. This will display a screen where you can choose a study and any 
of the references. By clicking Move, the selected references will be moved to the 
study. 

9.5.2 Using drag/drop or cut/paste to move references 
To drag and drop a reference:  

• Click the reference and keep the mouse button down. 
• Move the mouse pointer to the insertion point (which becomes highlighted). This will copy the 

reference. If you wish to move the reference, hold down the <shift> key during this procedure. 
(The mouse pointer will indicate the difference between copying and moving by displaying a 
small ‘+’ sign when copying.) 

• Release the mouse button. 
 

To copy or move a reference by using the copy or cut and paste function: 

• Highlight the reference you wish to copy or move. 
• Select Copy or Cut from the Edit menu on the menu bar, or click the copy or cut button. 
• Highlight the study or section to which the reference is to be copied or moved. 
• Select Paste from the Edit menu on the menu bar, or click the paste button. 

! Although references can be 'copied' to the appropriate study under References to studies, they 
must be 'moved' from Classification pending to Additional references or Other published versions 
(i.e. the shift key must be held down when using drag and drop). 

9.6  Deleting references 
To delete a reference: 

• Highlight the reference. 
• Click Delete, you will be asked if you really want to delete the reference. 
• Click Yes to confirm deletion, or No to cancel. 

! If you want to delete all the classification pending references for a review, you can do this by 
highlighting the Classification pending heading and clicking Delete. 

9.7  Exporting references 
To export a set of references from a review in tagged text format (see appendix E): 

• Highlight the review. 
• Use Export / References... from the File menu. 
• Remove the check marks for any sections you do not wish to export. 
• Select a filename and location. 
• Click Save. 
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10 Comparisons 
Study data cannot be entered into RevMan until the comparisons and outcomes have been 
specified and this is done using Comparisons and Data. Comparisons must be between two 
alternative forms of care. For example, in a review of nicotine replacement therapy for smoking 
cessation, one comparison may be in the format Nicotine replacement therapy versus no such 
therapy, and the next may be in the format one type of Nicotine replacement therapy versus 
another. Some reviews will only have one comparison, but others may have more. The decision 
about how many to include will depend on a variety of factors, including what is clinically 
sensible, how many interventions are to be included, and how many outcomes are to be assessed. 

For each comparison, the effect on one or more outcomes/categories can be examined. Outcomes 
are listed below each comparison, and reviewers should try to begin with those outcomes which 
they regard as most important. Each outcome/category can be divided into sub-categories but this 
will not be required for many reviews. If sub-categories are used, there are several ways of setting 
them up as RevMan allows you to specify whether data from different sub-categories should be 
combined statistically or not. The two main uses of sub-categories are: 

• For different subgroups, where the results of each study appear only once, and results of the 
different subgroups can be combined to give an overall result (e.g. grouping the studies by 
dose, specific intervention, or setting of care) 

• For different types of outcome, where a study may appear in more than one sub-category and 
it might not make sense to combine the outcomes into an overall result (e.g. ‘mortality for the 
baby’ can be divided into stillbirths, perinatal deaths, and neonatal deaths; or an outcome could 
be presented for different points in time, such as relapse at 3 and 12 months). 

! The usual convention is that outcomes report adverse events (death, for example, rather than 
survival). 

! The structure of the Comparisons and data section needs to be carefully planned beforehand. It 
may be helpful to write it out on paper first.  

10.1 Setting up the comparisons 
You create the comparison table by first adding the comparisons, and then adding the relevant 
outcomes / categories and sub-categories. 

To add a comparison: 

• Highlight Comparisons and data. 
• Click Add to open a Comparison window. 
• If you wish to insert the new comparison at a specific point in the list you can assign an 

already used number and then have RevMan renumber the subsequent comparisons.  
• Type in the description for the comparison. 
• When finished, click OK to save. 

 
! Remember the first form of care should be the ‘experimental’ intervention and the second the 

‘control’. For example, antibiotic vs placebo, or early vs late discharge from hospital, where 
antibiotic and early discharge are the ‘experimental’ interventions. 

10.1.1  Outcomes / categories 
Outcomes can only be entered after a comparison has been set up. To add a dichotomous, 
continuous, generic inverse variance or IPD outcome/category: 
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• Highlight the parent comparison for this outcome. 
• Click Add. 
• If you wish to insert the new outcome at a specific point in the list you can assign an already 

used number and then have RevMan renumber the subsequent outcomes. 
• Select the type of data to be entered for that outcome (default is dichotomous). See 11.1 for a 

description of the different data types. 
• Under the General tab, type in the description for the outcome; and type in the labels for the 

two comparison groups. These are used in the data tables in RevMan and in the analyses on the 
meta-analysis graph published in the CDSR. (See section 16.2.5 ‘Settings’ for how to specify 
the default labels which will be applied to any new outcome in your copy of RevMan.) 

• For generic inverse variance outcomes, also type in Name for effect measure (e.g. “odds ratio”, 
“adjusted odds ratio”, “rate ratio”, “mean difference”, “hazard ratio”) and select the type of 
Entered data. You can choose between original scale and logarithm. Quantities like odds ratios, 
risk ratios and hazard ratios should be entered as ln(effect size) and SE[ln(effect size)]. Non-
ratio measures such as mean differences and risk differences should be entered in their original 
metric. The data entered will be used in the meta-analysis. However, for presentation of results, 
the ratio measures will be converted to their original metric (odds ratio etc.). The information 
entered here will determine whether this happens. 

• Under the Statistics tab, select what totals should be calculated statistically (see below, default 
is Yes (totals)); and select the Default study confidence interval, Default outcome confidence 
interval and Default statistical method for this outcome when the review is published in the 
CDSR. (See section 16.2.5 ‘Settings’ for how to specify the default setting which will be 
applied to any new outcome in your copy of RevMan.) 

• Under the Graph tab, type in the Meta-analysis graph labels, and select the default graph scale 
which will be used when the review is published in the CDSR. (See section 16.2.5 ‘Settings’ 
for how to specify the default labels and setting which will be applied to any new outcome in 
your copy of RevMan.) 

• For generic inverse variance outcomes, you can choose whether to include columns for the 
number of participants in the two groups. These numbers are for display only.  

• When finished, click OK to save. 
 

The choices for Totals are: Yes (totals), Subtotals only, or No (no totals). They should be selected 
in the following situations: 

Yes:  Combined analysis will be shown for each sub-category and for the sub-
categories combined. 

Subtotals only: Combined analyses will be shown for each sub-category, but the sub-
categories will not be combined. 

No: Combined analyses will not be shown for each sub-category, or for the 
sub-categories combined. 

  

10.1.2  Other data outcomes 
Other data outcomes are added just like the four other types of outcome (see section 10.1.1 
'Outcomes'), but they have a different set of characteristics. They should be used for any data that 
cannot be entered into the data tables of the other types of outcome. 

! Always use Other data for study results, not Additional tables. 

• Under the General tab, type in the description for the outcome; and select the number of 
columns (maximum 10) and rows per study (maximum 10) in the data table. 
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! If you decrease the number of columns or rows, any data already entered in the columns or rows 
that are removed will be lost when you click OK. 

• Under the Column headings tab, assign headings to the relevant columns (maximum 20 
characters each). If a heading is wider than a column, all of the heading will not be visible in 
RevMan, but it will be visible when published in the CDSR. 

10.1.3 Sub-categories 
These can only be entered after the comparison and outcome have been set up, and will have the 
same data type as the outcome to which they relate. To add a sub-category: 

• Highlight the parent outcome / category for this sub-category. 
• Click Add. 
• If at least one sub-category has already been added to the outcome you will be taken straight to 

the sub-category screen. Otherwise, you will be asked whether you wish to add a sub-category 
or a study. 

• If you wish to insert the new sub-category at a specific point in the list you can assign an 
already used number and then have RevMan renumber the subsequent sub-categories.  

• Type in the description for the sub-category. 
• When finished, click OK to save. 

10.2 Copying 
The same outcome is often used in different comparisons, and the same sub-category might be 
used for several outcomes. You can use the drag and drop function or copy and paste to copy 
items within the table of comparisons. With both methods you will be given the option of copying 
the associated study data along with the outcome or sub-category. 

To drag and drop an outcome or sub-category: 

• Click the outcome or sub-category and keep the mouse button down. 
• Move the mouse pointer to the insertion point (which becomes highlighted). This will copy the 

outcome or sub-category. If you wish to move the outcome or sub-category, hold down the 
<shift> key during this procedure. (The mouse pointer will indicate the difference between 
copying and moving by displaying a small ‘+’ sign when copying.) 

• Release the mouse button. 
• Confirm whether or not you wish to copy any associated study data. 

 
To copy by using the copy and paste function: 

• Highlight the outcome or sub-category you wish to copy. 
• Select Copy from the Edit menu on the menu bar, or click the copy or cut button. 
• Highlight the Comparison to which the item is to be copied. 
• Select Paste from the Edit menu on the menu bar, or click the paste button. 
• Confirm whether or not you wish to copy any associated study data. 

10.2.1 Copying to other reviews 
Comparisons and outcomes can also be copied to other reviews in the Tree view. You can choose 
to also copy all the associated study data. 

! When copying the associated study data, any studies that were not already present in the target 
review will also be copied to the Included studies section of the target review. 
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10.3 Editing 
Comparisons, outcomes and sub-categories can be edited. To edit: 

• Highlight the appropriate item, then click Edit.  
• Edit as required. 
• When finished, click OK to save. 

10.4 Deleting 
Comparisons, outcomes and sub-categories can be deleted. To delete an item: 

• Highlight the item to be deleted, and click Delete. 
• Confirm that the item should be deleted. 
• Subsequent items will not be renumbered. You will need to edit their numbers to do this. 

! Warning! Deleting an item will also delete all its subheadings, including the data tables, and any 
data entered there will be lost. 

10.5 Renumbering 
When updating a review you may wish to change the order of some items or, if an item is deleted, 
renumbering may be required. The same numbers cannot be used twice. Therefore, if 
comparison.outcomes 01.01 and 01.02 are to have their order reversed, 01.01 must first be 
renumbered to 01.03, then 01.02 can be renumbered to 01.01, and finally 01.03 can be 
renumbered to 01.02. These changes would be made by editing the relevant outcomes (see section 
10.3 'Editing'). 
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11 Data tables 

Before entering data, you should check the appropriate studies and references have been entered 
as Included, and that the comparisons have been correctly constructed. If there are sub-categories, 
data are entered at this level. If not, data are entered at the outcome/category level. 

To add studies to the data table: 

• Highlight the outcome or sub-category. 
• Click Add. 
• If you are at the outcome level and data for at least one study has already been added at this 

level you will be taken straight to the Add study screen. Otherwise, you will be asked whether 
you wish to add a sub-category or a study. 

• A list of included studies that have not yet been added to the outcome or sub-category will be 
shown. To add one of these to the table, highlight it and click Add or double-click the study. 
When you add the first study to a data table, the table will be opened. 

• When finished, click Close. 

11.1 Adding data 
Data can be entered in two ways: typed in directly or pasted in from either a spreadsheet (for 
continuous, dichotomous, generic inverse variance and IPD data) or word processor table (for 
other data). Double data entry can be used to check for inaccuracies in the entering of the data. 

To type in data: 

• After adding the relevant studies, highlight one of these in the Comparisons and data part of 
the Tree view. 

• Click Edit or double-click the study.  
• Type in the data (see below for guidance on different data types). 
• The right-click menu also allows you to Cut row, Copy row and Paste row. 
• You can assign a particular order to the studies by numbering them with up to four digits. This 

order can be used in the analyses by selecting User Defined from the Sort menu in RevMan 
Analyses. You can also temporarily sort by this order in a data table by clicking on the Order 
column heading. This is useful for pasting in data (see below) which are not ordered by study 
identifier. 

• When finished, click Save then Close. If you click Close without saving, you will be asked if 
you want to save the changes before exiting. If you answer ‘No’ the changes to the text will be 
lost. 

 
To paste in data from a spreadsheet (for continuous, dichotomous, generic inverse variance and 
IPD data) or from a word processor table (for other data): 

• After adding the relevant studies, open the data table. 
• Open the relevant spreadsheet or word processor and mark and copy the relevant section (both 

rows and columns for a spreadsheet or one row at a time for a table). 
• Return to RevMan, right-click the top left cell of the area you want to paste into and select 

Paste from spreadsheet (or Paste row) from the menu. 
• When finished, click Save then Close. If you click Close without saving, you will be asked if 

you want to save the changes before exiting. If you answer ‘No’ the changes to the text will be 
lost. 
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Continuous: Data are entered as number of participants (N), mean and standard 
deviation (SD) for each of the two groups. 

Dichotomous:  Data are entered as number of events (n) and participants (N) for 
each of the two groups. 

Individual patient data: Data are entered as number of events (n) and participants (N) for 
each of the two groups; and observed - expected (O-E) and variance 
statistics calculated outside of RevMan. RevMan can calculate the 
O-E and variance for any study for which these statistics are not 
available. To do this, highlight any cell belonging to the relevant 
study and click Calculate. If you do not have O-E and variance 
statistics for any of the studies, you should use the dichotomous data 
type. 
! Warning! The calculate function will overwrite any previously 
entered cell content in the relevant O-E and Variance cells. 

Generic inverse variance: Data are entered as estimate of treatment effect (Estimate), standard 
error of estimate (SE) and number of participants (N) for each of the 
two groups (optional). 

Other: Data are entered as free text. 

11.1.1 Adding studies 
As well as adding studies to the data tables in the Tree view window, they can be added when the 
data table is being edited. To do this: 

• Open the relevant data table. 
• Click Add study. 
• A list of included studies that have not yet been added to the outcome or sub-category will be 

shown. To add one of these, highlight it and click Add or double-click the study. 
• When finished, click Close. 

11.1.2 Double data entry 
To enter the same data twice to check for inaccuracies (not available for Other data): 

• Open the relevant data table. 
• Click Double data entry. 
• An empty data table will be shown into which the data can be entered again. 
• When the data have been entered, click Check. 
• The data cells in the two tables are compared one by one from left to right for each study. If a 

discrepancy is found, the relevant Study ID and column will be shown and the check will stop. 
The error needs to be corrected before checking can resume. 

• When finished, click Cancel. 

11.2 Editing data 
To edit data: 

• Highlight the relevant study in the Comparisons and data part of the Tree view. 
• Click Edit or double-click the study.  
• Edit the data. 
• When finished, click Save then Close. If you click Close without saving, you will be asked if 

you want to save the changes before exiting. If you answer ‘No’ the changes to the text will be 
lost. 
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11.3 Deleting data 
To delete a study from the data table: 

• Highlight the relevant study in the Comparisons and data part of the Tree view. 
• Click Delete. 
• Confirm that the study should be deleted. 
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12 Additional tables 

As well as including data tables in your review, you can also create and include up to 99 tables to 
show other information. These tables are customisable tables and can be linked to from the text. 
To add an additional table: 

• Highlight Additional tables in the Tree view then click Add. 
• Enter the title for the table (maximum 80 characters). This appears as the table heading in the 

Tree view and when the review is published in the CDSR, but it is not included as part of the 
link in the text. 

• Specify the number of rows (maximum 99) and columns (maximum 10). 
• Enter the column headings (maximum 20 characters each). If a heading is wider than a 

column, all of the heading will not be visible in RevMan, but it will be visible when published 
in the CDSR. 

• Click Save. 
• Switch to the Table tab to enter information. 
• When finished click Save, then Close. 
 

See Appendix B 'Using Tables' for help on resizing columns and rows. 
 

To edit an Additional table:  

• Highlight the relevant table and click Edit, or double-click it. 
• Edit as required. If you change the table number, the links to the table in the Text of review 

will automatically be updated. 
• When finished, click Save then Close. If you click Close without saving, you will be asked if 

you want to save the changes before exiting. If you answer ‘No’ the changes will be lost. 
 

To delete an Additional table: 

• Highlight the relevant table. 
• Click Delete. 
• Confirm that the table should be deleted. 
 

See section 7.11 'Insert link to table' on how to link to an Additional table from the Text of review. 

12.1 Inserting rows and columns 
To insert a row, right click in a cell just below the row you wish to insert and choose Insert row 
above from the menu. To insert a column, right click in a cell just to the right of the column you 
with to insert and choose Insert column to the left from the menu. 

To add a row at the bottom or a column to the far right, use the Properties section. 

12.2 Deleting rows and columns 
To delete a row or a column, right click in a cell belonging to the row or column and choose 
Delete row or Delete column from the menu. 
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12.3 Copying additional tables to other reviews 
An additional table can be copied to another review: 

• Highlight the table in the tree view. 
• Click Copy. 
• Highlight the Additional tables heading in the other review. 
• Click Paste. 
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13 Analyses 

13.1 Overview 
RevMan Analyses is designed to calculate statistics used in meta-analyses and to display the 
results in tabular and graphical form. The program replaces MetaView in RevMan from version 
4.2. The analyses it performs and the graphs and displays are similar to those of MetaView 4.1, so 
if you are familiar with MetaView it should be easy to use. 

The program has several extra features compared to MetaView, such as the ability to export 
graphics in a number of formats – including formats suitable for presenting graphs in paper 
publications. Other features include copying images (or parts of images) to the clipboard, printing 
of more than one image on a page, and support for the generic inverse variance statistical method 
(new in RevMan 4.2). 

RevMan Analyses opens with a Summary screen listing each outcome on a separate line, along 
with information on the number of studies contributing to the analysis and an estimate of effect 
size.  

13.2 Summary screen 
RevMan Analyses opens with a summary screen listing the comparisons and associated outcomes 
included in the systematic review. At the top of the screen, the total number of included studies in 
the review is displayed. (This is obtained from the list of included studies and does not necessarily 
correspond to the number of studies used in the analysis.) 

Up to five columns of text are displayed. The last four contain text for outcomes only: 

Comparison/Outcome: Shows the descriptions of each of the comparisons in the review and, 
indented under each comparison, the outcomes belonging to the 
comparison. 

No. of Studies: Shows the number of studies contributing to the analysis for the 
outcome. Studies where the effect estimate is not estimable are not 
counted. Studies that appear in more than one subgroup are counted 
more than once. No number is shown if the outcome is set to No totals 
or Subtotals only in RevMan. 

No. of Participants: Shows the total number of participants for the studies contributing to 
the analysis for the outcome. No number is shown if the outcome is set 
to No totals or Subtotals only in RevMan. 

Statistical Method: Shows the default statistical method used to analyse the outcome and 
the chosen value for the confidence interval. The statistical method 
used on the summary screen cannot be changed in RevMan Analyses – 
only in RevMan. You can, however, reanalyse each outcome when it is 
displayed on the detail screen. If the text Other data is shown, the data 
have been entered in RevMan as free text and cannot be analysed using 
RevMan Analyses. 

Effect Size: Shows the effect estimate and the confidence interval resulting from 
the meta-analysis of the outcome. The text No total is shown if the 
outcome is set to No totals in RevMan. The text Subtotals only is 
shown if the outcome is set to Subtotals only in RevMan. 

The first column is always displayed. The display of the four remaining columns can be toggled 
on/off using the Display menu.  
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In addition to the text columns, two special columns are displayed: A column of buttons to open a 
detail screen and a column of check boxes to select one or more outcomes (for example, for 
printing). 

13.2.1 Opening a detail screen 
There are three ways to open the detail screen for an outcome: 

• Double click an outcome. 
• Highlight an outcome and click the grey button to the left of the outcome. 
• Highlight an outcome and choose Detail from the Display menu.  

! There are no detail screens for other data outcomes.  

13.2.2 Selecting outcomes 
If you want to print or save the detail screens for a subset of outcomes, you must select them first. 
This is done by clicking in the check boxes next to the outcomes. If you click in a check box for a 
comparison, all the outcomes belonging to the comparison will be selected. Click again to 
deselect. 

13.2.3 Resizing the columns 
To change the width of a column, move the mouse pointer to the top of the screen to the division 
line between two columns. The mouse pointer will change into a double arrow. Click and hold the 
left mouse button while moving the mouse to resize the column to the left of the division line. 

13.3 Detail screen 
A detail screen shows the result of analysing a single outcome. A detail screen provides additional 
information and flexibility compared to the summary screen. For example, you can alter the scale 
of the graphs, the confidence interval to be shown, and select which columns you want to appear 
on the screen. Modifications made when viewing a detail screen do not affect the summary 
screen. The detail screens look slightly different depending on which type of data is being 
analysed: dichotomous, continuous, generic inverse variance, or individual patient data (IPD). A 
fifth type of data, other data, does not have a detail screen. 

13.3.1  Components of a detail screen 
At the top of the screen, the review title, the comparison description, and outcome description are 
displayed. Next follow the headings for a number of columns.  The choice of columns to display 
can be set using the Display menu.  These include Study or sub-category (always displayed), Raw 
data, Graph, Weight, Effect estimate and CI, Year, Quality, User defined order, and O-E and 
variance. Next follow the results of the analyses. These are divided into sub-categories where 
defined. Unless the outcome is set to No totals in RevMan, each sub-category is followed by a 
subtotal section. At the bottom of the screen a total section is displayed (unless Totals have been 
set to No totals or Subtotals only in RevMan). 

13.3.2  The graph 
The graph is a forest plot where the confidence interval (CI) for each study is represented by a 
horizontal line and the point estimate is represented by a square. The size of the square 
corresponds to the weight of the study in the meta-analysis. The confidence interval for totals are 
represented by a diamond shape (♦). The scale used on the graph depends on the statistical 
method. Dichotomous data (except for risk differences) are displayed on a logarithmic scale. 
Continuous data and risk differences are displayed on a linear scale. Generic inverse variance data 
are displayed on either a logarithmic scale or a linear scale depending on the settings in RevMan. 
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To change CIs or scales, use the Display menu. 

13.3.3  Statistical tests 
For each total or subtotal is given the test for heterogeneity (Chi² statistic with its degrees of 
freedom (df) and P-value), the statistic I² measuring the extent of inconsistency among results, 
and the test for overall effect (Z statistic with P-value). 

13.3.4  Settings 
Two types of settings affect how a detail screen looks:  

1. The default settings specified in RevMan for each outcome (including statistical method, 
confidence interval, choice of totals and scales). If you modify any of these for a detail screen 
in RevMan Analyses it will stay that way as long as the review is open (even if you close and 
re-open the screen), but the settings will revert to the default the next time the review is 
opened. 

2. Settings specified in RevMan Analyses (including columns displayed, zoom level and sort 
order). These settings are global in RevMan Analyses, i.e. not specific for individual 
outcomes. The settings are saved between sessions – even if you close the program. 

13.3.5 Moving the visible area 
A detail screen may take up more space than is available on screen. In such cases, only a section 
is visible at any time. There are three ways to move the visible area to see other parts of the detail 
screen: 

• Left-click anywhere on the detail screen to centre the view there. 
• Drag the scroll bars using the mouse. 
• Use the following keys (make sure that Num Lock is off if you want to use the numeric key 

pad): 
• Left arrow:  Moves the area to the left. 
• Right arrow:  Moves the area to the right. 
• Up Arrow:  Moves the area up. 
• Down Arrow:  Moves the area down. 
• Page up:  Moves the area up one page. 
• Page down:  Moves the area down one page. 
• Home:  Moves the area to the left edge. 
• End:  Moves the area to the right edge. 
• Ctrl + Page up:  Moves the area to the top. 
• Ctrl + Page down:  Moves the area to the bottom. 

13.3.6  Zooming 
To zoom in on an area of the detail screen, hold down Ctrl on the keyboard and left-click with the 
mouse in the middle of the area. Repeat for a larger magnification. To zoom out again, hold down 
Ctrl and right-click the graph.  Repeat for a smaller magnification. RevMan Analyses has a total 
of nine zoom levels, where the default is number four. 

13.4 Menu options 
The menu options allow you to save the screen in various formats, copy the screen to the 
clipboard, select objects, choose the columns to display, change the scale and confidence interval, 
sort the studies, and change the statistical method. 
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13.4.1 File menu 
The File menu has different options depending on if you are viewing the summary screen or a 
detail screen. 

Open data file: Closes the current data file and opens another one. Since RevMan 
Analyses works automatically with RevMan 4.2 or above, it is usually 
easiest to just highlight the review title in RevMan and click Analyses. 
Multiple reviews can be analysed at the same time, each in its own 
instance of RevMan Analyses. 

Save data: Saves entered and calculated data for use in other programs. See 
section 13.6 ‘Exporting data’. 

Save image(s): Saves either the active detail screen or a selection of outcomes as one 
or more graphics files. See section 13.5 ‘Exporting graphs’. 

Save RTF file: Saves either the active detail screen or a selection of outcomes as a 
RTF file. See section 13.5 ‘Exporting graphs’. 

Copy to clipboard: Detail screens only. Copies the active detail screen window to the 
Windows clipboard from where it can be pasted into other programs. 
See section 13.5 ‘Exporting graphs’. 

Print:  Options for printing the summary screen, a selection of detail screens 
or, when viewing a detail screen,  just the active screen. See section 
13.8 ‘Printing’. 

Exit  Closes RevMan Analyses. 

13.4.2 Edit menu 
The Edit menu is only available for detail screens. It allows you to change between View mode 
and Select mode. 

View mode: Changes to a mode where no selection is allowed. This is the default 
setting when opening a detail screen. 

Select mode: Changes to a mode where you can select objects using the mouse. To 
select multiple objects hold down shift and click each object in turn, or 
hold down the left mouse button and drag a rectangle around the 
objects to select. Selecting objects can be used to export only part of an 
image, see section 13.5 ‘Exporting graphs'. 

13.4.3  Display menu 
The following options appear on the Display menu for the summary screen:  

Detail screen:   Opens the detail screen for the highlighted outcome. See Detail 
screens. 

Studies: Toggles display of the Studies column on/off. 

Participants:  Toggles display of the Participants column on/off. 

Statistical method:   Toggles display of the Statistical methods column on/off. 

Effect estimate:  Toggles display of the Effect estimate column on/off. 

 

The following options appear on the Display menu for detail screens. The availability of the 
options may vary depending on the type of data you are viewing. Inappropriate or unavailable 
options are dimmed. 
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Logarithmic scale: Sets the scale displayed at the bottom of the graph. This menu is 
only active for statistical methods where the results should be 
displayed using a logarithmic scale. 

Linear scale: Sets the scale displayed at the bottom of the graph. This menu is 
only active for statistical methods where the results should be 
displayed using a linear scale. 

Study Confidence Interval:  Sets the confidence interval limits displayed for individual studies 
to either 90%, 95% or 99%. This number is also displayed at the top 
of the graph. 

Total Confidence Interval:  Sets the confidence interval limits displayed for totals and subtotals 
to either 90%, 95% or 99%. This number is also displayed next to 
the words Total or Subtotal in the Study or sub-category column. 

The following options control whether or not to display columns of data in the detail window.  
These options may be selected (shown by a check mark) or deselected by a single click with the 
left mouse button. 

Raw Data: Treatment and control group raw data . 

Graph: The graphical depiction of the results. 

Weight:  The contribution of the study to the overall result. 

Effect estimate and CI : The individual study point estimate and confidence interval. 

Year: The year the study was conducted, as entered by the reviewer. 

Quality: A quality score as entered by the reviewer. 

User defined order: A ranking entered by the reviewer to allow re-ordering of entries 
using Sort. 

O-E and variance: The observed minus expected statistic. O-E is only available for 
data analysed using the Peto method. The columns are not available 
for continuous data at all. 

Funnel plot: Opens a window displaying a funnel plot for the current outcome. 
The option is not available when a random effects models is chosen 
or for outcomes where no total is calculated. See section 13.7 
‘Funnel plots’. 

! Changing the confidence interval on a detail screen does not affect the summary screen. This 
screen can only be changed by setting the default options in RevMan.  

! Changing the displayed columns does not affect open detail screens other than the active one, but 
next time a detail screen is opened it will use the new settings. 

13.4.4 Sort menu 
The Sort menu is only available for detail screens. It allows you to change the order in which 
individual studies appear. The following options are available: 

By study:  Sorts by study identifier. Not case sensitive, i.e. studies beginning 
with upper and lower case letters are ‘mixed’. 

By weight: Sorts by weight with the lowest weight first. Studies where the 
weights are not estimable are placed first. 

By effect estimate:  Sorts by effect estimate with the lowest effect estimate first. Studies 
where the effect estimates are not estimable are placed first. 
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By year: Sorts by year, if available (i.e. if it has been entered into RevMan). 
Studies where the year is empty are placed first. 

By quality: Sorts by quality of allocation concealment (A, B, C, D) as entered 
into RevMan. 

By user defined: Sorts by user defined order, if available (i.e. if it has been entered 
into RevMan). 

13.4.5 Statistics menu 
The options on this menu allow you to recalculate the active detail screen using the following 
effect measures and statistical methods: 

Peto odds ratio (Peto OR): For dichotomous data and IPD. Also called Peto’s assumption free 
method. Fixed effect only. 

Odds ratio (OR): For dichotomous data. Fixed effect and random effects models. 

Relative risk (RR): Also called risk ratio. For dichotomous data. Fixed effect and 
random effects models. 

Risk difference (RD): For dichotomous data. Fixed effect and random effects models. 

Weighted mean difference 
(WMD): 

For continuous data. Fixed effect and random effects models. 

Standardised mean 
difference (SMD): 

For continuous data. Fixed effect and random effects models. 

Fixed effect model: Uses Mantel-Haenszel method for dichotomous data (except for 
data analysed using the Peto method) or the inverse variance 
method for continuous or generic IV data. 

Random effects model: Uses the DerSimonian and Laird method. 

! Changing the statistical method on a detail screen does not affect the summary screen. The 
summary screen can only be changed by setting the default options in RevMan.  

13.4.6  Previous outcome and next outcome 
The Previous outcome and Next outcome menu bar buttons will close the current detail screen and 
open the one for the previous or next outcome, respectively. 

13.4.7  Window menu 
This menu contains the following options: 

Arrange all: Attempts to arrange and resize all open windows so they are visible 
at the same time. 

Cycle: Moves focus to the next open window. 

The bottom of the menu shows a list of the windows currently open. Click a title to move the 
focus to the relevant window. 

13.4.8 Help menu 
The Help menu provides access to the online help file (which can also be opened with the F1 key) 
and the About screen, which displays the version and date of RevMan Analyses. 
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13.5 Exporting graphs 
The graphs in RevMan Analyses can be exported for use in other applications in three different 
ways. You can: 

• Copy a detail screen, or parts of it, to the clipboard and paste it into another application, such 
as PowerPoint. 

• Save one or more detail screens as image files, which can later be inserted in another 
application. 

• Export a RTF document containing one or more detail screens. 

13.5.1 Export formats 
Choosing the best export method may depend on a number of factors such as the advantages and 
disadvantages of the various formats. The following description may help you decide.  

‘Vector’ (or ‘object-oriented’) image files are internally simply a series of exact descriptions of 
the shapes composing the image. This means that whenever they are displayed on screen or 
printed out, the quality of the output will be as high as possible on the chosen medium. For 
example, if you enlarge a vector image to the maximum zoom factor in an image viewing 
program, a circle will still have a smooth, round edge. Vector files will generally produce the 
highest quality output, but they are not suitable for all media. Currently, the standards for the 
World Wide Web do not include widespread support for vector images. RevMan Analyses can 
generate two types of vector formats:  

Windows Meta File 
(WMF): 

WMF is Windows' own format. It is well supported within - but not 
outside of - Windows. It cannot readily be used on the WWW. The 
file size is small. 

Enhanced Meta File 
(EMF): 

An improved version of Windows Meta File (WMF), which can 
handle more kinds of objects. It is difficult to recommend whether to 
use WMF or EMF. Try both and see which one works best. 

Additionally, when detail screens are exported to an RTF document, each screen is inserted in the 
document as a WMF image. 

‘Bitmap’ image files consist of a grid of tiny squares, called ‘pixels’, and are fixed at a specific 
resolution. For example, if you enlarge a bitmap image to the maximum zoom factor in an image 
viewing program, a circle will have a rough, jagged edge. Although this constitutes a quality 
limitation, bitmap files are the only option for photographic images and are widely supported, also 
on the WWW. File formats that support compression are often used to reduce file size. Different 
formats use different forms of compression. To balance compression and image quality, the 
method of compression should be suited to the content of the image. PNG files have the best 
compression method for analysis graphs, but the format also has limitations.   

RevMan Analyses can generate three types of bitmap formats: 

BMP: Windows' own bitmap format. Can be used in most Windows 
programs but not on the WWW. Files are not compressed, so file size 
can be big. 

JPG: The standard format for photographic images. Line drawings may 
look blurred. Can be used on the WWW. Good compression. 

PNG: Emerging standard for non-photographic bitmaps, but is not fully 
supported by all browsers. Good compression. 
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13.5.2 Copying to the clipboard 
To copy the active detail screen window to the Windows clipboard from where it can be pasted 
into other programs, use Copy to clipboard from the File menu. If a subset of objects on the 
screen is selected (see section 13.5.5 ‘Selecting parts of graphs’), only that part of the screen is 
copied to the clipboard. The submenu gives you the choice of three formats: as Bitmap (BMP), as 
Windows Meta File (WMF) and as Enhanced Meta File (EMF). 

13.5.3 Saving images 
Your options for saving images depend on whether you are viewing a detail screen or the 
summary screen. 

To save a single detail screen to a file, open the screen and use Save image from the File menu. If 
a subset of objects on the screen is selected (see section 13.5.5 ‘Selecting parts of graphs’), only 
that part of the screen is saved to the file. Choose one the five formats: as bitmap (PNG), as 
bitmap (BMP), as bitmap (JPG), as Windows Meta File (WMF) and as Enhanced Meta File 
(EMF) from the submenu, and specify the file name and location.  

To save several detail screens as individual files, use Save images… from the File menu on the 
summary screen. You can then choose to save only the Highlighted outcome, the Selected 
outcomes or All outcomes. Choose one the five formats: as bitmap (PNG), as bitmap (BMP), as 
bitmap (JPG), as Windows Meta File (WMF) and as Enhanced Meta File (EMF). The name of 
each file is built from the File name prefix entered in the box (default is Img) and the comparison 
and outcome numbers for the outcome. For example, the default name for saving comparison 01, 
outcome 02 as BMP is ‘Img0102.bmp’. When you click the Save button, a dialogue box will 
allow you to choose the directory where the files should be saved. Use the Close button to close 
the screen. 

13.5.4 Saving as RTF 
If you wish to save the summary screen or wish to save multiple images in a single document, you 
can use the Save RTF file option. It is available from the File menu of both the summary screen 
and detail screens, but it is only when viewing a detail screen that the option of saving the Current 
screen will be available. The options that are always available are: to save the Summary screen, 
the Highlighted outcome, the Selected outcomes and All outcomes. When you click the Save 
button, a dialogue box will allow you to specify the file name and location. Use the Close button 
to close the screen. 

! When you save the summary screen to RTF, the resulting file will not look exactly like the 
summary screen. It will contain all the information, but you may wish to add some formatting in a 
word processor, for example by converting it into a table. In Microsoft Word, this can be done by 
highlighting all the text and using Convert Text to Table… from Word’s Table menu. 

13.5.5 Selecting parts of graphs 
When viewing a detail screen, the Edit menu allows you to change between View mode and Select 
mode. 

View mode: Changes to a mode where no selection is allowed. This is the default 
setting when opening a detail screen. 

Select mode: Changes to a mode where you can select objects using the mouse. To 
select multiple objects hold down shift and click each object in turn, 
or hold down the left mouse button and drag a rectangle around the 
objects to select. Selecting objects allows you to copy or export only 
part of an image. 
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13.6 Exporting data 
You can export the entered and calculated data in two formats. Use Save data… from the File 
menu and select one of the two formats (see below).  

13.6.1   Tab delimited text file 
This option is used to save all the data – both entered and calculated – to a plain text file from 
which it can be imported into other programs. You can use this file if you want to use another 
program to create graphs other than the ones RevMan Analyses can produce. The text file uses a 
tab delimited format where each field of information is separated by a tab character. The first row 
contains the headings and each of the following rows contains data for either a comparison, 
outcome, sub-category, or study. This format can be imported easily into most spreadsheets. 

13.6.2  HTML tables 
This option saves the data for a set of outcomes in HTML format. You have the choice between 
saving the data for the Highlighted outcome, the Selected outcomes, All outcomes, or the Current 
screen (detail screens only), and you can choose whether the tables should have cell borders or 
not. The tables include rows for Study or sub-category, the raw data, Weight, and effect estimate 
and CI. The tables do not include the graph (this is shown as an empty column). 

13.7 Funnel plots 
A funnel plot screen is opened from the Display menu of a detail screen using the Funnel plot 
option. 

A funnel plot is a plot of SE(effect estimate) or SE(log(effect estimate)) versus effect estimate for 
each study under the outcome. The studies are marked by a dot. If a study lies outside the graph, 
an arrow pointing towards the study is displayed instead. Note that the y-axis is inverted. The 
scale and effect estimate measure on the x-axis is taken from the detail screen from which the 
funnel plot was opened. If you want to change either of these two properties, close the funnel plot 
window, change the settings for the detail screen, and open a new funnel plot window. The overall 
effect estimate is indicated by the vertical dotted line. The Display menu also contains an option 
for toggling display of 95% CI lines on/off. 

Please consult the Cochrane Reviewers' Handbook for information on the interpretation of funnel 
plots. 

Funnel plot screens are similar to detail screens with respect to printing and saving images. 

! Funnel plots must be inserted into reviews as Additional figures (see 14) in order to be shown in 
the published review. 

13.8 Printing 
To print one or more screens using the current settings, use Print… from the File menu. The 
following options are available: 

Summary screen: Prints the summary screen only. 

Highlighted outcome: Prints the detail screen for the outcome highlighted on the summary 
screen. 

Selected outcomes: Prints the detail screens for all outcomes selected with a check mark 
on the summary screen. 

All outcomes: Prints the details screens for all outcomes. 

Current screen: Prints the active detail screen or funnel plot. 
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If you leave the Start each outcome on a new page box unchecked, RevMan Analyses will try to 
fit as many outcomes on each page as possible. 

! RevMan Analyses may print slowly on some computers using Windows 95/98. If you experience 
such problems, you can check the Alternative printing routine box. Instead of using RevMan 
Analyses’ internal printing functions, this it will generate an RTF file and ask any available 
programs capable of printing RTF files, e.g. WordPad, to do so. 

When you are ready to print, click the Print button. A dialogue box will be displayed where you 
can choose the printer to use. Use the Close button to close the screen. 
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14 Additional figures 
The Additional figures section can be used to include graphs and other images which are not 
generated automatically when a review is published in the CDSR. Some of these graphs, such as 
funnel plots, can be generated by RevMan Analyses. Other graphs and images may come from 
other sources. 

! The images you include in RevMan will not be edited or otherwise improved by others, but will 
be published ‘as is’. It is therefore important that you only include images that are fully fit for 
publication. You can use the ‘Checklist for using additional figures’ in Appendix K to help ensure 
this. 

To include an additional figure: 

• Expand the Figures heading in the tree view, highlight Additional figures, and click Add. 

• This will open the Additional figure window, and the Open picture window. 

• Select the type of file to open, either BMP (Windows bitmap), PNG (Portable Network 
Graphics) or JPG (Joint Photographic Experts Group). 

• Locate and select the file to open. 

• Click OK. 

• Edit the Figure ID and Caption as necessary (see below). 

• Click Save and Close.  

The additional figure window has the following elements: 

Figure ID: An identifier (maximum 20 characters) for the figure, which must be 
unique within this review. This is used for linking to the figure from the 
text and for ordering the figures in the Tree view. It is not possible to use 
an ID for a figure which has already been used for a reference because 
RevMan stores additional figures as a special type of reference. When 
using several figures, the IDs should be consistent and consecutive, i.e. 
Figure 01, Figure 02, etc. 
 
! You should always include at least one link to a figure in the text 

- otherwise the figure will not display in the published version. 

Open file: This will allow you to replace the current figure with another file. 

Caption: A description of the figure that will appear next to it. If permission to 
publish a copyrighted figure is granted, the final phrase of the figure 
caption must be: “Copyright © [Year] [Name of copyright holder, or other 
required wording]: reproduced with permission.”. 

! One way of entering the '©' sign in the Caption text box is to 
copy and paste it from this User Guide. 

Fit to screen: If the Fit to screen box is checked, the image is resized so all of it is 
visible on screen. If not, the image is shown in the original size clipped to 
the size of the screen. This setting has no influence on how the image is 
stored internally in RevMan, which is always in the original size. 

Image info: Click to see technical information about the image including the 
dimensions, the number of colours and the file size.  
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! Image info for BMP files shows image type as PNG because 
RevMan internally converts BMP images to this format. 

! Large images take up lots of disk space - a single large image can easily take up ten times the total 
space used for the text and tables of the review. This leads to very large export files. Scanned 
images can be especially space consuming because the resolution may be much higher than 
needed. Always use images with a good balance between resolution and detail, and keep the 
number of images small. 

14.1 Editing and deleting Additional figures 
You cannot edit the images of additional figures in RevMan. To do this you need an external 
bitmap editor. If you need to export the figures from RevMan, you can do this by using the export 
as HTML option, see 16.1.2.  

To edit the description or the caption of a figure, highlight it in the tree view and click Edit. 

To delete a figure, highlight it in the tree view and click Delete. 

14.2 Preparing images for inclusion in RevMan 
Images included in RevMan as Additional figures will be published without any modification, so 
the aim should be to achieve the highest possible quality. But a review export file containing only 
a few additional figures can easily be several times larger than a review without them. This can 
severely impact the exchange of reviews over the internet, and careful consideration should 
therefore to be given to ways of minimising file size without sacrificing quality. 

! Never use Additional figures for content that can be included in other ways in RevMan, for 
example as standard graphs in the Table of comparisons or as Additional tables. 

Optimising images can be a complex task, and this text only provides an overview. If you have no 
previous experience with image editing, you should consider obtaining additional guidance and/or 
assistance. 

The basic principles outlined here are: 

• Be aware of copyright issues 

• Crop if needed 

• Resize down as needed, but retain dimensions and legibility 

• Save graphs and tables as PNG 

• Save photos as JPEG 

• Take a close look to check the quality 

These points are also included in the ‘Checklist for using additional figures’ (see Appendix K), 
which it is recommended you use for each Additional figure. 

14.2.1  Copyright 
Remember to verify that you have either copyright ownership or the written consent of the 
copyright holder of any images you include. You are required to attest to this on the Permission 
for Publication form. 

14.2.2  Editing images 
During editing you can lose detail due to resizing or compression. Therefore you should always 
save a separate copy of the original image in the best possible quality before you do any editing. 
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This way you retain the option of later modifying it differently, or supplying it in an improved 
format in case other options become available.  

Image editing software typically has a large number of features, and many of those might be used 
to improve images used as Additional figures. This text will only concentrate on the basics of 
preparing an image, but if you have experience with other features such as contrast adjustment, or 
blur and sharpen filters, you can of course use these as needed. 

Please refer to the documentation for your image editing software for details on how to perform 
the tasks described here. 

14.2.3  Cropping 
The first step in editing an image is to present only the necessary information. This is especially 
important when working with screen dumps acquired by using the Print Screen key, but you 
should always remove any surplus content or blank space at the edges. For graphs and tables you 
can leave a margin of a few pixels. Use the ‘Crop’ feature of your software for this. 

If there is caption or heading text in the image, it should also be removed and entered in the 
appropriate field in RevMan instead (see below). Any legends used should remain in the image. 

14.2.4 Resizing 
Although the originals you begin with should generally be in a high resolution, the images 
published with your review should be of a manageable size for the reader. This means that they 
should be kept reasonably small, but never so small that text becomes illegible. If your image 
exceeds 800 pixels in width even after cropping and careful resizing, you should consider if the 
information could be presented differently. Avoid changing the aspect ratio of images, unless you 
have a good reason to. 

You should be particularly careful when resizing graphs (such as funnel plots saved from RevMan 
Analyses), as they typically have lines that are only one pixel wide. These lines can disappear 
completely if resized wrongly. In such cases you should leave the image at its original size. 

14.2.5 Saving in a format accepted by RevMan 
RevMan can accept three different file formats: PNG, JPG and BMP (see below). Choosing the 
best format involves matching the contents of the image with the characteristics of the various 
formats. 

14.2.6 Image formats 
Many image file formats support some form of compression to reduce file size. There are various 
types of compression, each with its advantages and disadvantages. Some forms of compression 
are lossy, meaning that detail is lost every time the compression is applied, while others are 
lossless. Another aspect that determines file size is the ‘bit-depth’ of a file, which relates to how 
much space is used for storing colour information. An 8-bit file can contain 256 separate colours, 
while a 24-bit file can contain 16 million. For images with only a few colours, using a format with 
a high bit-depth will be a waste of space. 

The three file formats accepted by RevMan each also have a grayscale variant, where they have 
up to 256 shades of grey.  

PNG Portable Network Graphics 

PNG comes in several variants, for example PNG-4, PNG-8 and 
PNG-24. The number reflects the bit-depth, which determines how 
many different colours the image can contain; in this case it is 16, 
256, and 16 million, respectively. PNG compression is lossless and is 
especially well suited for images with areas of uniform colour. It is 
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likely that PNG will end up replacing the GIF format for use on the 
WWW. 

JPG JPEG (Joint Photographic Experts Group)  

JPEG files normally have a bit-depth of 24, allowing for 16 million 
colours. JPEG compression is lossy and well suited for complex 
images with many colours, such as photographs. It is possible to 
choose the level of compression. For high quality, only a low level of 
compression should be used. 

BMP Windows Bitmap 

BMP files are typically 24 bit and not compressed. RevMan converts 
BMP files to PNG files internally, so BMP is only provided as option 
for those that cannot provide the other formats. 

 

14.2.7  Balancing quality and file size 
For each type of image, there is a combination of file format and compression level that gives the 
best balance between optimal quality and file size: 

! For line drawings, such as funnel plot graphs or advanced tables, PNG is the best format. 

! For photos, JPEG with a high quality (or low compression) setting is the best format. 

The software you use for preparing the images for RevMan may have a feature where you can 
preview the output file before saving it, allowing you to experiment further with the optimisation. 

14.2.8 Verifying quality 
Once you have saved the image in one of the formats supported by RevMan, open the file and 
zoom in to check that there are no problems with quality. In JPEG photos files look out for 
squares shapes caused by too strong compression. In PNG files check that all lines and writing is 
clear, and that the colours of the original are retained.  
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15 Comments and criticisms 

Up to 99 comments and criticisms can be attached to each review. Each of these contains the 
following information: 

Number: Each comment and criticism has a unique number. This is used to 
order the Comments and criticisms in the Tree view. 
! If you would like two comments and criticisms to change 
places, assign an unused number to one of them, move the other by 
changing its number, then, if necessary, change the number of the 
first. 

Title: This title (maximum 80 characters) appears as the table heading in 
the Tree view and when the review is published in the CDSR. 

Summary: For the criticism editor’s summary, if there is one. 
Reply: For the reviewer’s reply. 
Contributors: To list those who submitted the criticism. 

15.1 Adding, editing and deleting comments and criticisms 
To add a comment, highlight the Comments and criticisms heading in the tree view and click Add. 

To edit a comment, highlight the comment in the tree view and click Edit. 

To delete a comment, highlight the comment in the tree view and click Delete. 
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16 The main window’s menu bar 

The menu bar contains: File, Edit, Action, View, Window and Help.  

16.1 File 
The File menu allows you to: import and export reviews, text, contact details, and references; 
compare two reviews; check a review for empty sections; set up your printer; print a review, a 
publication form, the Tree view and all contact details; view a status report; and exit RevMan. 
(Importing and exporting of text and references is discussed above, see sections 7.5 'Importing 
text' and 9.3.3 'Importing references'. For information about importing contact details, see 5.1.2. 

16.1.1 Import reviews 
To import from a RevMan 4 file: 

• Select Import / Reviews… from the File menu. 
• You will be prompted to select the file you wish to open. 
• You will then be prompted to select the review(s) in this file which you wish to import. 
• Select or deselect an individual review by clicking on the box to its left. 
• Use Select all to select all reviews and Deselect all to clear all selections. 
• Clicking Mark imported reviews as selected in the tree view may help you identify the reviews 

you just imported if RevMan contains many reviews 
• Click OK to import. 

  
! If RevMan already contains a version of a review being imported, you will be prompted to select 

whether to import the review as a secondary version, as the primary version (making the previous 
primary version secondary) or not import it. 

! If a review is imported which contains contact details for a reviewer whose Contact ID is already 
in RevMan, but the contact details differ, you will be prompted to verify the contact details. If the 
contact details are for the same reviewer, choose to either keep the current contact details or 
overwrite with those from the import file. If the contact details are for different reviewers, choose 
to assign a new Contact ID to the reviewer in the import file. 

! It is also possible to import and export reviews in RevMan 3.x format. However, this should not 
be necessary, as RevMan 4.x has been mandatory for several years. 

16.1.2 Export reviews 
This option should be used for making backups of your reviews, to transfer a review from one 
copy of RevMan to another, to send completed reviews to the co-ordinator of your CRG, or to 
create a file which can be worked on in another piece of software. Reviews can be exported as 
RevMan 4 files, RevMan 3.1 files (obsolete) and HTML files. 

To export reviews as a RevMan 4 file: 

• Highlight then Select the review(s) in the Tree view (this step is optional). 
• Use Export / Selected reviews… from the File menu. 
• Modify the selection of reviews as needed, and click OK. 
• Specify a filename and location. 
• Click Save to export. 
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! RevMan 4 files can contain multiple reviews, and have the filename extension ‘.rm4’. 

To export the text of a review, its references and tables in HTML format:  

• Highlight the review in the Tree view. 
• Use Export / Review as HTML… from the File menu. 
• Specify a filename and location. 
• Click Save to export. 

! Warning! The file will not contain analyses graphs and data, and HTML files cannot be imported 
into RevMan. 

16.1.3 Comparing two reviews 
In some cases you might wish to identify which sections differ between two versions of a review 
or two reviews. RevMan allows you to do this. If you want to make a finer comparison of the text 
(for example to identify the actual differences) you should export the two reviews as HTML files 
and compare them in a word processor with the appropriate facility. To compare two reviews in 
RevMan:  

• Select the two relevant reviews (or versions of a review) in the Tree view. (You cannot 
compare more than two reviews.) 

• Use Compare selected reviews from the File menu. 
• The result of comparing the reviews will be shown. A check mark is placed next to the 

headings for the sections where they differ. 
• If necessary, click Print list to print a list of the headings for the sections where the reviews 

differ. 
• When finished, click OK. 

 ! Any difference, even a comma or an extra space, will lead to the identification of a section as 
different. 

16.1.4 Checking a review 
You can check a review against the list of validation rules (see Appendix J). To check a review: 

• Highlight the relevant review in the Tree view. 
• Use Check review from the File menu. 
• A report divided into errors and warnings will be displayed. 
• If necessary, click Print report to print this report. 
• When finished, click OK. 

16.1.5 Printing 
The Print window allows you to choose which section(s) of the highlighted review to print. 

Select or deselect a section by clicking on the box to its left. Use Select all to select all sections 
and Deselect all to clear all selections. 

Use Protocol only to select the sections relevant to a protocol only (Cover sheet, Text of review, 
Other references, and Additional tables). When you click this button, the As protocol option will 
automatically be selected. When this option is selected, only the Additional references section of 
Other references will be printed, and only the following sections in the Text of review will be 
printed: Background, Objectives, Criteria for considering studies for this review, Search strategy 
for identification of studies, and Methods of the review. 

To print all, or parts, of a review: 
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• Highlight the relevant review in the Tree view. 
• Use Print... from the File menu. 
• Select or deselect a section by clicking on the box to its left. 
• Use Select all to select all sections and Deselect all to clear all selections. 
• Choose if you wish to print As protocol. 
• If necessary, click Preview to see how the currently highlighted section will look when 

printed. The preview window has a tool bar with options to browse though pages, zoom in and 
out, close the window or print the previewed section (independently of any sections otherwise 
marked for printing). You must close the preview window before you can continue working in 
RevMan. 

• Click Print to print the selected sections. 
• When finished, click Close. 

! If you choose to print the Analyses graphs, these will be printed with the default options as 
specified in RevMan and RevMan Analyses. There is no preview for analyses graphs. RevMan 
will prompt you if there are more than 10 graphs to print. To print individual Analyses graphs, 
print them from within RevMan Analyses. 

 
Use Print setup… from the File menu to access the various options for your printer. 

16.1.6 Print publication form 
This option will generate a 'Conditions of Publication/Information on Authors' form using the 
contact information available for the Contact reviewer and any co-reviewers.  

This form must be filled out, signed by all contributors listed on the by-line (i.e. in the ‘List of 
reviewers for citation’), and returned to your Review Group Co-ordinator before your review can 
be published as a Cochrane review. A new form should be filled out for every substantive 
revision. 

16.1.7 Print tree view 
This option will print the current tree view. Only visible (expanded) items will be printed. This 
option can be used, for instance, to print a list of reviews or a list of reviewers. 

16.1.8 Print contact details 
This will generate a report with all the contact details currently stored in RevMan. You will be 
given the choice of seeing a preview first or sending the report directly to the printer. 

16.1.9 Status 
This window shows: 

• The total number of reviews in RevMan (divided into full reviews, protocols and titles). 

• The total number of primary versions (divided into full reviews, protocols and titles). 

• The number of contacts which are assigned to one or more reviews as contact reviewer. 

• The number of contacts which are assigned to one or more reviews as co-reviewer. 

• The total number of contacts. 

16.1.10 Exiting 
Exit RevMan by selecting Exit from the File Menu, or simply click the X button at the top right 
hand corner of the main window. 



RevMan 4.2 User Guide 

53 

16.2 Edit 
The Edit menu allows you to: undo and redo; cut, copy and paste; select all text in the current text 
box; find and replace; search all reviews; check spelling in the current text section; count the 
number of words in the current text section; and change the settings for RevMan.  

16.2.1 Find and replace 
This option is only available within text boxes (i.e. Text of review, Comments and criticisms; 
individual cells of Characteristics of...studies, Other data and Additional tables; Notes; the Text 
tab of What’s new; the Description tab of Contact details, Footnotes, and References). To use 
Find and replace: 

• Open the relevant text box. 
• Use Find and replace from the Edit menu. 
• Type in the text string you wish to search for.  
• Select Match case to search for strings with the same combination of upper- and lower-case 

letters (e.g. searching for ‘sum’ with this option selected would not find ‘Sum’). 
• Select Whole word to search for whole words only (e.g. searching for ‘sum’ with this option 

selected, would find ‘sum’ but not ‘summary’). 
• Select Whole text to search forwards and backwards from the cursor position in the current text 

section. (If it is not checked, the search will be forwards only.) 
• If appropriate, type in the text to replace your search string. (If left blank, using Replace or 

Replace all will delete without replacement.) 
• Click Find next to activate the search for the next occurrence of the search string. (If found, 

the string will be highlighted.) 
• Click Replace to replace the highlighted string.  
• Click Replace all to replace all occurrences found, without prompting. 
• When finished, click Cancel. 

16.2.2 Search 
If you wish to search for a text string in specific sections of all reviews, you should use the Search 
function. To use Search: 

• Use Search... from the Edit menu. 
• Type in the text string you wish to search for. Spaces will be displayed as dots '·' in this field. 
• Select Match case to search for strings with the same combination of upper- and lower-case 

letters (e.g. searching for ‘sum’ with this option selected would not find ‘Sum’). 
• Select Whole word to search for whole words only (e.g. searching for ‘sum’ with this option 

selected, would find ‘sum’ but not ‘summary’). 
• Select which sections should be searched in all reviews. 
• Click Search to activate the search. The result is that all reviews containing the text string will 

be selected. 
• When finished, click Cancel. 

16.2.3  Spell check 
This feature is only available within text boxes (i.e. Text of review, Comments and criticisms; 
individual cells of Characteristics of...studies, Other data and Additional tables, Notes; the Text 
tab of What’s new; the Description tab of Contact details, Footnotes, and References). It checks 
the spelling of the box or a highlighted string of text. You can use a UK English or a US English 
dictionary, both or neither (see section 16.2.5 ‘Settings’). To check spelling: 
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• Open the relevant text box. 
• Use Spell check... from the Edit menu. Any words not found in dictionary will be shown. 
• Click Help in the Check spelling window for help. 
• When finished, click Cancel. 

! To check the spelling of a part of the text only, highlight that part before using Spell check. 

! If you use this feature in a table, RevMan will ask if you want to check the entire table. If you 
reply No, only the active cell will be checked 

16.2.4 Word count 
This feature is only available within text boxes (i.e. Text of review, Comments and criticisms; 
individual cells of Characteristics of...studies, Other data and Additional tables, Notes; the Text 
tab of What’s new; the Description tab of Contact details, Footnotes, and References). It counts 
the number of characters and words in the box or a highlighted string of text. To perform a word 
count: 

• Open the relevant text box. 
• Use Word count from the Edit menu. (A character and word count will be shown). 
• Click OK to close. 

! To count words in a part of the text only, highlight that part before using Word count. 

16.2.5 Settings 
The settings are global (i.e. they apply to your copy of RevMan and not just to a single review). If 
settings affecting a currently open window are changed, the changes will not always take effect 
until the window has been closed and opened again. The settings are arranged under five tabs: 
General, Directories, Display, Statistical, and Graph. 

The following items are found under the General tab 

Timed backup every __ 
minutes: 

This number (0-99) determines how often RevMan will export a 
backup file containing all reviews worked on in the current 
RevMan session. The file, 'timed backup.rm4', is located in the 
folder specified under Default directory for import/export files. 
Up to four backup files are stored. Instead of overwriting the ‘timed 
backup.rm4’ file for each timed backup, this file is renamed ‘timed 
backup 1.rm4’. If a file with that name already existed, it is 
renamed ‘timed backup 2.rm4’ and, similarly, this will then be 
renamed ‘timed backup 3.rm4’ if necessary. So if the backup 
interval is set to 10 minutes, file 1 is approximately 10 minutes old, 
file 2 is 20 minutes old, and file 3 is 30 minutes old. You can 
restore from any of these files if you have made changes to a review 
which you wish to undo. 
The latest backup file, ‘timed backup.rm4’, is deleted when 
RevMan closes down normally, so RevMan knows that if this file 
exists the next time it is opened, there were problems in the last 
session. In that case it will automatically suggest importing the file.
A value of '0' minutes will disable the backup completely. 

Turn off full backup when 
RevMan shuts down: 

Use this to disable the full backup (not recommended). 
Each time RevMan closes down normally, it copies all its data files 
from the Data directory (or another location if the database has been 
moved) to the Database backup directory specified (see below). If 
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the computer freezes or the power fails, the database may be 
damaged. When RevMan is opened the next time, it will detect the 
damage and restore the database from the backup. This will bring 
the database back to the state of the last normal shutdown, but all 
the modifications from the last session may be lost (depending on 
the type of damage). These modifications can, however, be restored 
from the modified review backup (see above). 
! If you want to prevent the full database backup 

occasionally, hold down Ctrl while closing RevMan. 

Date format: This selects the format for your copy of RevMan but it will not 
necessarily be used when reviews are published in the CDSR. The 
options are: day month year (DMY), year month day (YMD) and 
month day year (MDY). 

Default contact reviewer: This reviewer will be applied to any new review in this copy of 
RevMan. Changing this default does not affect the contact reviewer 
for existing reviews. 

Spell checking: RevMan has both a UK English and a US English dictionary for 
spell checking. You can choose which one to use or to use both (in 
which case both ways of spelling are accepted). 

 
The following items are found under the Directories tab: 

Directory for temporary files: The directory that RevMan will use for storing temporary files 
during import and export. The default is ‘c:\windows\temp’. Any 
directory which is not write protected and is on a drive with 
sufficient free space can be used. 

Default directory for 
import/export files: 

RevMan will start with the directory shown here when you are 
prompted to specify a file name during import and export. 

Database directory: Determines the location of the files RevMan uses to hold all the 
information currently in this copy of RevMan. The default is the 
subfolder 'DATA' which is automatically generated in the 
installation folder (e.g. 'C:\PROGRAM FILES\REVMAN 
4.1\DATA\'). 
You can change the location of the database to any drive with 
sufficient space, including mapped network drives. This means that 
several people can work on the same review(s), by sharing the 
database over a network. However, only one person will be able to 
access the database at any one time. 
If you change the database location to a folder already containing  
database files, you will be prompted to either use the database 
found in the new location or overwrite that database with the data 
currently in RevMan. 
Remember that RevMan needs to access the files continually, so 
caution is advised in using this feature. Moving the database to a 
slow drive or a drive with unstable access will have a severe impact 
on the performance of RevMan. 

Database backup directory: The directory where RevMan will save a copy of the database when 
exiting.  

 

The following items are found under the Display tab: 
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Show tooltip texts: Enable or disable the display of tooltip texts (i.e. the short texts 
that appear when the pointer is paused over some buttons and 
boxes) 

Review information panels 
displayed: 

Select which review information panels are displayed in the status 
bar at the bottom of the Tree view when the Show review 
information option is enabled (see section 16.4 'View'). 

Title of tree view window: If you have more than one copy of RevMan installed you may 
want to change the title of the Tree view window to distinguish 
the different versions. For example, if you have a copy of 
RevMan with drafts and a copy of RevMan with published 
versions of reviews you could change the title of the Tree view 
window of the former to 'Tree view (draft RevMan)'. 

Tree view font: Set the font used in the Tree view or in the tables by clicking on 
Change font. 

 
Table font: Set the font used in tables (characteristics of studies, additional 

tables, other data tables) by clicking on Change font. 
 

The options available under the Statistical and Graph tabs allow you to choose the settings which 
will be applied in the Comparisons and data table when any new outcome is created in this copy 
of RevMan. Changing these defaults does not affect the labelling for existing outcomes. These 
settings are for: study confidence interval, outcome confidence interval, statistical method for 
dichotomous data, statistical method for continuous data, group labels, graph labels and graph 
scales. 

16.3 Action 
The Action menu allows you to: add, edit and delete; select and deselect reviews, for exporting 
and comparing; select and deselect studies for inclusion and exclusion from the analyses (see 
section 16.3.1 ‘Omitting studies from analyses); browse up and down; and view the Analyses. 
These actions can also be done using the buttons on the main window’s toolbar. 

16.3.1 Omitting studies from analyses 
It is possible to perform sensitivity analysis by omitting study data from the meta-analyses. To 
omit a study from the analyses, highlight the study under the comparison in the Tree view and use 
Deselect from the Action menu then open RevMan Analyses using Analyses. To include a study 
again, highlight it and use Select from the Action menu. Omitting studies will not affect an 
already open analyses window. 

! The deselecting of a study only affects the study in this copy of RevMan. It will not be registered 
in an export file or published in the CDSR. If you wish to remove a study from the analyses you 
will need to delete it from the data tables (see section 11.3 ‘Deleting data’). 

16.4 View 
The View menu allows you to customise the appearance of the Tree view window. It allows you to 
structure the Tree view by either Reviews or Reviewers; to sort the reviews in the Tree view and to 
choose whether or not to display the icons. 

! If you wish to change the font used in the Tree view you need to change the relevant setting (see 
section 16.2.5 ‘Settings’). 



RevMan 4.2 User Guide 

57 

Show reviewers: The default is for the Tree view to be structured by reviews but you 
can select this option to sort the reviews by contact reviewer. If 
selected, each reviewer in this copy of RevMan will be shown with 
the reviews shown as subheadings under the relevant contact 
reviewer.  
When this is enabled, you can Add a new review to a particular 
reviewer. 
! The tree structure is rebuilt each time you select or de-select 
Show contact reviewers. This may take some time if your computer 
is slow or your copy of RevMan contains many reviews. 

Show review information: This will display review information panels at the bottom of the 
Tree view window. These panels display information on the review 
the currently highlighted item belongs to (see section 16.2.5 
'Settings'). 

Sort by: The reviews can be sorted by title (this is the default and is 
alphabetical); status (titles then protocols then full reviews); Date 
next stage expected or Date edited (most recent at the bottom). 

16.5 Window 
The Window menu allows you to: arrange all open windows in RevMan, cycle through the open 
windows, or select an open window. 

16.6 Help 
The Help menu allows you to view the help file, frequently asked questions about RevMan, the 
Cochrane Reviewers’ Handbook, a list of new features in RevMan 4.0 and 4.1, and details about 
your copy of RevMan. The Help menu also allows you to report a problem and to propose a 
change. 

 
RevMan help: Opens the help file. 
FAQ: Displays an Internet link to the list of frequently asked questions and 

answers about RevMan. 
Handbook: Displays the electronic version of the Cochrane Reviewers’ 

Handbook. 
Style Guide: Displays the electronic version of the Style Guide for Cochrane 

reviews. 
What’s new: Displays a list of the changes made in RevMan since the previous 

version. 
RevMan exercise: Opens the RevMan exercise. 
Report a problem: Gives details on how to report a problem. If you have an Internet 

browser on your computer, this will allow you to submit your 
information electronically using a pre-defined form. 

Propose a change: Gives details on how to propose a change for a future version of 
RevMan. If you have an Internet browser on your computer, this will 
allow you to submit your proposal electronically using a pre-defined 
form. 

About RevMan: Displays information about this version of RevMan. 
 
 



RevMan 4.2 User Guide 

58 

17 Uninstalling RevMan 
To uninstall RevMan, use the 'Add/Remove Programs' feature from your Windows Control Panel. 

Sometimes the uninstall program will be unable to delete some files or directories (e.g. the 
RevMan installation directory). These will then have to be deleted manually. 
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Appendices 

Appendix A: List of Icons 
 

 Reviews  Primary reference 

 Full review (primary version)  
Reference 
 

 Secondary version of review  
Studies 
[Grey pen] 

 Protocol  
Included study 
[Red pen] 

 Title  
Included study omitted from 
meta analysis 

 
Selected review 
[Red border]  

Excluded study 
[Blue pen] 

 
Selected protocol 
[Red border]  

Study awaiting assessment 
[Green pen] 

 
Selected title 
[Red border]  

Ongoing study 
[Yellow pen] 

 Reviewers  Table 

 Reviewer  Comparison 

 Cover sheet  
Dichotomous outcome or 
sub-category 

 Source of support  
Continuous outcome or 
sub-category 

 What's new  IPD outcome or sub-category 

 Notes  
Other data outcome or 
sub-category 

 Text sections  Comments and criticisms 

 Text section  
Generic inverse variance 
outcome or sub-category 

 Figures  Additional figures 

 Analyses   
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Appendix B: Using Tables 

Resizing columns 
To resize columns, move the mouse pointer to the top of the division line you wish to move. 
When the mouse pointer changes to a double arrow, hold down the left mouse button and drag the 
line to the desired position. 

Resizing rows 
To resize rows, move the mouse pointer to the far left of the division line between the topmost 
two rows. When the mouse pointer changes to a double arrow, hold down the left mouse button 
and drag the line to the desired position. This will resize all rows in the table. 

Split bar 
Some tables can be split into two separate panes which allows you to, for example, fix the study 
id in the left pane while using the vertical scroll bar in the right pane. To move the split bar, click 
and drag the black square in the bottom left corner on the table. 

! Find and replace and Word count only work within the active cell of a table. 
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Appendix C: Using the keyboard 

General 
Buttons with an underlined character can be activated with Alt-<character>, e.g. Add study can be 
activated by pressing Alt-a. 

All windows, except the Tree view, can be closed by using the Esc key. 

Tree view 
The up and down arrows will move the highlight up or down; the right arrow key will expand a 
highlighted heading while the left arrow will collapse it. The enter key will expand or collapse a 
heading, while it will act as pressing the Edit button for an item, for example ‘Title’. The ‘*’ 
(multiplication) key on the keypad will completely expand all subheadings belonging to the 
highlighted heading. 

Ctrl-L will act as pressing the Edit button, also for headings.  

Use these shortcuts to open various windows for the highlighted review: 

Ctrl-T  Text of review 

Ctrl-N  Notes  

Ctrl-I  Characteristics of included studies 

Ctrl-E  Characteristics of excluded studies 

Ctrl-O  Characteristics of ongoing studies 

Ctrl-D Comparisons and data 

Ctrl-H Handbook 

Ctrl-M Meta-analyses 

Tables  
Ctrl-<up> go to previous row 

Ctrl-<down> go to next row 

Tab  go to next column 

Shift-Tab  go to previous column 

Standard Windows shortcuts: 
Ctrl-A Highlight all text 

Ctrl-C Copy 

Ctrl-X cut 

Ctrl-V paste 

Ctrl-P Print 

Ctrl-F Find and replace 

Ctrl-Z Undo 
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Appendix D: Working with co-reviewers 
 

Many Cochrane reviews involve more than one reviewer and, even if they do not, it is necessary 
for the electronic version of the review to be passed around several people including the Review 
Group Coordinator and members of the CRG’s editorial team. It is, therefore, very important that 
reviewers ensure that the development of a Cochrane review can be tracked and that the most up-
to-date version of their review is the one that goes forward for publication in the Cochrane 
Database of Systematic Reviews. In order to help with this, RevMan assigns a unique identifier 
whenever a new review is created and this identifier cannot be edited. In addition, although 
several different versions of a review can be held within RevMan, only one can be marked as the 
“primary version”. 

Some of the important points for reviewers to keep in mind when passing around electronic copies 
of their review are: 

• If co-reviewers begin working on the review by “creating” it within their own copy of 
RevMan 4, the contact reviewer must copy their work into her master copy since the versions 
created by co-reviewers will not have the correct unique identifier.  

• The contact reviewer must ensure that she always submits the most up-to-date version of the 
review to her CRG for consideration and publication. It might help with this if the reviewer 
“archives” previous versions of the review (e.g. by copying these to a floppy disk or saving 
them in a different directory on her computer’s disk drive). 

• If co-reviewers are working on different aspects of a review in sequence, they should ensure 
that the most up-to-date version of the review is passed between them in the correct order. 

• If co-reviewers are working on a review at the same time, the contact reviewer will need to 
copy their work into the primary version before submission to their CRG.  

• The “unpublished CRG notes” field in the review can be used for messages between co-
reviewers and/or between the reviewers and their editorial team. It might be worthwhile 
embedding a date in these messages, to provide a guide to the sequence of events. In addition, 
if this field is used to keep a running log of changes to the review it will allow these to be 
tracked more easily. Co-reviewers might also like to paste a copy of their textual changes into 
this field, to make it easier for the changes to be incorporated into the master copy (if this is 
held by the contact reviewer). 

• The “compare two reviews” function can be used to identify sections that are different 
between two reviews within a copy of RevMan. This might prove useful when trying to 
identify which is the most up-to-date version of a review. 

Contact IDs 
Another aspect of working with co-reviewers is that RevMan requires contact information to be 
entered for co-reviewers. This means that each co-reviewer needs a Contact ID, which should be 
obtained from the CRG. 
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Appendix E: Reference format 

The Reference Types and Fields used in RevMan 4 
 
Reference types (RT) Description 
Journal article For all articles published in journals (e.g., full 

articles, news items, letters to the editor and 
conference abstracts) 

Book  
Section of book  
Conference proceedings For conference proceedings which do not use the 

same style as a journal article 
Correspondence For personal communications 
Computer program  
Unpublished data  
Other For, among other things, Internet publications and 

the Cochrane Reviewers' Handbook 
 
Fields and tags 
Authors (AU):  
English title (TI):  
Original title (TO):  
Journal/book/source (SO):  
Date of publication (YR):  
Volume (VL):  
Issue (NO):  
Pages (PG):  
Edition (EN):  
Editor(s) (ED):  
Publisher name (PB):  
City of publication (CY):  
Medium (MD):  
MEDLINE ID (AN): 
Other ID numbers (ID):  
Unpublished notes (NT):  
Study name (SN):  
 
The study name (SN:) tag is only used to identify a study when the Import studies function is used, see 8.6. 
It is not shown on screen. 

'Impossible' references 
The following section lists how 43 different reference types should be stored in RevMan. If you have a 
reference that does not fall into one of the 43 categories, you should use RT: Other and the AU, TI, SO and 
YR fields in a way that gives a correctly formatted reference.   
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How to store different types of reference in RevMan 4 - index 

Journal articles 
1a. Standard journal article 
1b. Standard journal article (as an option, if a journal carries continuous pagination throughout a volume) 
2. Journal article with organisation as author 
3. Journal article with no author given  
4a. Journal article not in English without an English translation of the title 
4b. Journal article not in English with an English translation of the title 
5. Journal article in volume with supplement  
6. Journal article in issue with supplement  
7. Journal article in volume with part 
8. Journal article in issue with part 
9. Journal article in issue with no volume 
10. Journal article with no issue and no volume 
11. Journal article with pagination in Roman numerals 
12. Journal article of a particular type 
13. Journal article containing retraction  
14. Journal article which has been retracted 
15. Journal article containing comment  
16. Journal article commented on 
17. Journal article with published erratum 

Books 
18. Books and Other Monographs with personal author(s)  
19. Books and Other Monographs with editor(s), compiler as author  
20. Books and Other Monographs with organisation as author and publisher  
21. Dissertation  

Sections of books 
22. Chapter in a book 
23. Book of the Bible  
24. Dictionary and similar references  
25. Classical material  

Conference proceedings 
26. Conference proceedings which do not use the same style as a journal article 
27. Paper in conference proceedings which do not use the same style as a journal article 

Correspondences 
28. Personal communications 

Computer programs 
29. Computer program 

Unpublished data 
30. Data on file  

Cochrane reviews 
31. Cochrane reviews 

Other 
32. Scientific or technical report  
33. Patent  
34. Newspaper article  
35. Audiovisual 
36. Legal material  
37. Map 
38. Unpublished material, in press 
39. Publications on the Internet 
40. Cochrane Reviewers' Handbook 
41. Section of Cochrane Reviewers' Handbook 
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1a. Standard journal article 
Reference type 
Journal article 
 
Authors:  You CH, Lee KY, Chey RY, Menguy R 
English title: Elec-trogastrographic study of patients with unexplained nausea, bloating and vomiting 
Journal/book/source: Gastroenterology  
Date of publication: 1980 Aug 
Volume: 79 
Issue: 2 
Pages: 311-4 
 
This will be output as:  
You CH, Lee KY, Chey RY, Menguy R. Elec-trogastrographic study of patients with unexplained nausea, bloating 
and vomiting. Gastroenterology 1980 Aug;79(2):311-4. 
 

1b. Standard journal article (as an option, if a journal carries continuous pagination 
throughout a volume) 
Reference type 
Journal article 
 
Authors: You CH, Lee KY, Chey RY, Menguy R 
English title: Elec-trogastrographic study of patients with unexplained nausea, bloating and vomiting 
Journal/book/source: Gastroenterology  
Date of publication: 1980 
Volume: 79 
Pages: 311-4 
 
This will be output as:  
You CH, Lee KY, Chey RY, Menguy R. Elec-trogastrographic study of patients with unexplained nausea, bloating 
and vomiting. Gastroenterology 1980;79:311-4. 
 

2. Journal article with organisation as author 
Reference type 
Journal article 
 
Authors: The Royal Marsden Hospital Bone-Marrow Transplantation Team 
English title: Failure of syngeneic bone-marrow graft without preconditioning in post-hepatitis marrow aplasia 
Journal/book/source: Lancet 
Date of publication: 1977 
Volume: 2 
Pages: 742-4 
 
This will be output as:  
The Royal Marsden Hospital Bone-Marrow Transplantation Team. Failure of syngeneic bone-marrow graft without 
preconditioning in post-hepatitis marrow aplasia. Lancet 1977;2:742-4. 
 

3. Journal article with no author given  
Reference type 
Journal article 
 
English title: Coffee drinking and cancer of the pancreas [editorial] 
Journal/book/source: BMJ 
Date of publication:1981 
Volume: 283 
Pages: 628 
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This will be output as:  
Coffee drinking and cancer of the pancreas [editorial]. BMJ 1981;283:628. 
 

4a. Journal article not in English without an English translation of the title 
Reference type 
Journal article 
 
Authors: Massone L, Borghi S, Pestarino A, Piccini R, Gambini C 
Original title: Localisations palmaires purpuriques de la derma-tite herpetiforme 
Journal/book/source: Annales de dermatologie et de venereologie 
Date of publication: 1987 
Volume: 114 
Pages: 1545-7 
 
This will be output as:  
Massone L, Borghi S, Pestarino A, Piccini R, Gambini C. Localisations palmaires purpuriques de la derma-tite 
herpetiforme. Annales de dermatologie et de venereologie 1987;114:1545-7. 
 

4b. Journal article not in English with an English translation of the title 
Reference type 
Journal article 
 
Authors: Berard J-P, Curt I, Piech J-J,Ruiz F 
English title: Hydroxyethylamidons versus gelatines: impact on the cost of  replacement in an emergency 
(resuscitation) service 
Original title: Hydroxyethylamidons versus gelatines: Impact sur le cout du rempissage dans un service de 
reanimation 
Journal/book/source: Annales Francaises d'anaesthesia reanimation 
Date of publication: 1995 
Volume: 14 
Pages: R335 
 
This will be output as: 
Berard J-P, Curt I, Piech J-J, Ruiz F. Hydroxyethylamidons versus gelatines: Impact sur le cout du rempissage dans 
un service de reanimation [Hydroxyethylamidons versus gelatines: impact on the cost of replacement in an emergency 
(resuscitation) service]. Annales Francaises d'anaesthesia reanimation 1995;14:R335. 
 

5. Journal article in volume with supplement  
Reference type 
Journal article 
 
Authors: Magni F, Rossoni G, Berti F 
English title: BN-52021 protects guinea-pig from heart anaphylaxis 
Journal/book/source: Pharmacological research communications  
Date of publication: 1988 
Volume: 20 Suppl 5 
Pages: 75-8 
 
This will be output as:  
Magni F, Rossoni G, Berti F. BN-52021 protects guinea-pig from heart anaphylaxis. Pharmacological research 
communications 1988;20 Suppl 5:75-8. 
 

6. Journal article in issue with supplement  
Reference type 
Journal article 
 
Authors: Gardos G, Cole JO, Haskell D, Marby D, Paine SS, Moore P 
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English title: The natural history of tardive dyskinesia 
Journal/book/source: Journal of clinical psychopharmacology 
Date of publication: 1988 
Volume: 8 
Issue: 4 Suppl 
Pages: 31S-37S 
 
This will be output as:  
Gardos G, Cole JO, Haskell D, Marby D, Paine SS, Moore P. The natural history of tardive dyskinesia. Journal of 
clinical psychopharmacology 1988;8(4 Suppl):31S-37S. 
 

7. Journal article in volume with part 
Reference type 
Journal article 
 
Authors: Hanly C 
English title: Metaphysics and innateness: a psycho-analytic perspective 
Journal/book/source The International journal of psychoanalysis 
Date of publication: 1988 
Volume: 69 
Issue: Pt 3 
Pages: 389-99 
 
This will be output as:  
Hanly C. Metaphysics and innateness: a psycho-analytic perspective. The International journal of psychoanalysis 
1988;69(Pt 3):389-99. 
 

8. Journal article in issue with part 
Reference type 
Journal article 
 
Authors: Edwards L, Meyskens F, Levine N 
English title: Effect of oral iso-tretinoin on dysplastic nevi 
Journal/book/source: Journal of the American Academy of Dermatology 
Date of publication: 1989 
Volume: 20 
Issue: 2 Pt 1 
Pages: 257-60 
 
This will be output as:  
Edwards L, Meyskens F, Levine N. Effect of oral iso-tretinoin on dysplastic nevi. Journal of the American Academy 
of Dermatology 1989;20(2 Pt 1):257-60. 
 

9. Journal article in issue with no volume 
Reference type 
Journal article 
 
Authors: Baumeister AA 
English title: Origins and control of stereotyped movements 
Journal/book/source: Monograph of the American Association of Mental Deficiency 
Date of publication: 1978 
Issue: 3 
Pages: 353-84 
 
This will be output as:  
Baumeister AA. Origins and control of stereotyped movements. Monograph of the American Association of Mental 
Deficiency 1978;(3):353-84. 
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10. Journal article with no issue and no volume 
Reference type 
Journal article 
 
Authors: Danoek K 
English title: Skiing in and through the history of medicine 
Journal/book/source: Nordisk medicinhistorisk arsbok 
Date of publication: 1982 
Pages: 86-100 
 
This will be output as:  
Danoek K. Skiing in and through the history of medicine. Nordisk medicinhistorisk arsbok 1982:86-100. 
 

11. Journal article with pagination in Roman numerals 
Reference type 
Journal article 
 
Authors: Ronne Y 
Original title: Ansvarsfall. Blodtransfusion till fel patient 
Journal/book/source: Vardfacket 
Date of publication: 1989 
Volume: 13 
Pages: XXVI-XXVII 
 
This will be output as:  
Ronne Y. Ansvarsfall. Blodtransfusion till fel patient. Vardfacket 1989;13:XXVI-XXVII. 
 

12. Journal article of a particular type 
Reference type 
Journal article 
 
Authors: Spargo PM, Manners JM 
English title: DDAVP and open heart surgery [letter] 
Journal/book/source: Anaesthesia 
Date of publication: 1989 
Volume: 44 
Pages: 363-4 
 
This will be output as:  
Spargo PM, Manners JM. DDAVP and open heart surgery [letter]. Anaesthesia 1989;44:363-4. 
 

13. Journal article containing retraction  
Reference type 
Journal article 
 
Authors: Shishido A 
English title: Retraction notice: Effect of platinum compounds on murine lymphocyte mitogenesis [Retraction of 
Alsabti EA, Ghalib ON, Salem MH. In: Japanese journal of medical science & biology 1979;32:53-65] 
Journal/book/source: Japanese journal of medical science & biology 
Date of publication: 1980 
Volume: 33 
Pages: 235-7 
 
This will be output as:  
Shishido A. Retraction notice: Effect of platinum compounds on murine lymphocyte mitogenesis [Retraction of 
Alsabti EA, Ghalib ON, Salem MH. In: Japanese journal of medical science & biology 1979;32:53-65]. Japanese 
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journal of medical science & biology 1980;33:235-7. 
 

14. Journal article which has been retracted 
Reference type 
Journal article 
 
Authors: Alsabti EA, Ghalib ON, Salem MH 
English title: Effect of platinum compounds on murine lymphocyte mitogenesis [Retracted by Shishido A. In: 
Japanese journal of medical science & biology 1980;33:235-7] 
Journal/book/source: Japanese journal of medical science & biology 
Date of publication: 1979 
Volume: 32 
Pages: 53-65 
 
This will be output as:  
Alsabti EA, Ghalib ON, Salem MH. Effect of platinum compounds on murine lymphocyte mitogenesis [Retracted by 
Shishido A. In: Japanese journal of medical science & biology 1980;33:235-7]. Japanese journal of medical science & 
biology 1979;32:53-65. 
 

15. Journal article containing comment  
Reference type 
Journal article 
 
Authors: Piccoli A, Bossatti A 
English title: Early steroid therapy in IgA neuropathy: still an open question [comment on: Nephron 1988;48:12-7] 
Journal/book/source: Nephron 
Date of publication: 1989 
Volume: 51 
Pages: 289-91 
 
This will be output as:  
Piccoli A, Bossatti A. Early steroid therapy in IgA neuropathy: still an open question [comment on: Nephron 
1988;48:12-7]. Nephron 1989;51:289-91. 
 

16. Journal article commented on 
Reference type 
Journal article 
 
Authors: Kobayashi Y, Fujii K, Hiki Y, Tateno S, Kurokawa A, Kamiyama M 
English title: Steroid therapy in IgA nephropathy: a retrospective study in heavy proteinuric cases [comment in: 
Nephron 1989;51:289-91] 
Journal/book/source: Nephron 
Date of publication: 1988 
Volume: 48 
Pages: 12-7 
 
This will be output as:  
Kobayashi Y, Fujii K, Hiki Y, Tateno S, Kurokawa A, Kamiyama M. Steroid therapy in IgA nephropathy: a 
retrospective study in heavy proteinuric cases [comment in: Nephron 1989;51:289-91]. Nephron 1988;48:12-7. 
 

17. Journal article with published erratum  
Reference type 
Journal article 
 
Authors: Schofield A 
English title: The CAGE questionnaire and psychological health [published erratum appears in British journal of 
addiction 1989;84:701] 
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Journal/book/source: British journal of addiction 
Date of publication: 1988 
Volume: 83 
Pages: 761-4 
 
This will be output as:  
Schofield A. The CAGE questionnaire and psychological health [published erratum appears in British journal of 
addiction 1989;84:701]. British journal of addiction 1988;83:761-4. 
 

18. Books and Other Monographs with personal author(s)  
Reference type 
Book 
 
Authors: Colson JH, Armour WJ 
Journal/book/source: Sports injuries and their treatment 
Date of publication: 1986 
Edition: 2nd 
Publisher name: S. Paul 
City of publication: London 
 
This will be output as:  
Colson JH, Armour WJ. Sports injuries and their treatment. 2nd edition. London: S. Paul, 1986. 
 

19. Books and Other Monographs with editor(s), compiler as author  
Reference type 
Book 
 
Authors: Diener HC, Wilkinson M, editors 
Journal/book/source: Drug-induced headache 
Date of publication: 1988 
Publisher name: Springer-Verlag 
City of publication: New York 
 
This will be output as:  
Diener HC, Wilkinson M, editors. Drug-induced headache. New York: Springer-Verlag, 1988. 
 

20. Books and Other Monographs with organisation as author and publisher  
Reference type 
Book 
 
Authors: Virginia Law Foundation 
Journal/book/source: The medical and legal implications of AIDS 
Date of publication: 1987 
Publisher name: The Foundation 
City of publication: Charlottesville 
 
This will be output as:  
Virginia Law Foundation. The medical and legal implications of AIDS. Charlottesville: The Foundation, 1987. 
 

21. Dissertation  
Reference type 
Book 
 
Authors: Youssef NM 
Journal/book/source: School adjustment of children with congenital heart disease [dissertation] 
Date of publication: 1988 
Publisher name: Univ. of Pittsburgh 
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City of publication: Pittsburgh (PA) 
 
This will be output as:  
Youssef NM. School adjustment of children with congenital heart disease [dissertation]. Pittsburgh (PA): Univ. of 
Pittsburgh, 1988. 
 

22. Chapter in a book 
Reference type 
Section of book 
 
Authors: Weinstein L, Swartz MN 
English title: Pathologic properties of invading microorganisms 
Journal/book/source: Pathologic physiology: mechanisms of disease 
Date of publication: 1974 
Pages: 457-72 
Editor(s): Sodeman WA Jr, Sodeman WA 
Publisher name: Saunders 
City of publication: Philadelphia 
 
This will be output as:  
Weinstein L, Swartz MN. Pathologic properties of invading microorganisms. In: Sodeman WA Jr, Sodeman WA, 
editor(s). Pathologic physiology: mechanisms of disease. Philadelphia: Saunders, 1974:457-72. 
 

23. Book of the Bible  
Reference type 
Section of book 
 
English title: Ruth 3:1-18 
Journal/book/source: The Holy Bible. Authorized King James version 
Date of publication: 1972 
Publisher name: Oxford Univ. Press 
City of publication: New York 
 
This will be output as:  
Ruth 3:1-18. In: The Holy Bible. Authorized King James version. New York: Oxford Univ.  
Press, 1972. 
 

24. Dictionary and similar references  
Reference type 
Section of book 
 
English title: Ectasia 
Journal/book/source: Dorland's illustrated medical dictionary 
Date of publication:1988 
Pages: 527 
Edition: 27th 
Publisher name: Saunders 
City of publication: Philadelphia 
 
This will be output as:  
Ectasia. In: Dorland's illustrated medical dictionary. 27th edition. Philadelphia: Saunders, 1988:527. 
 

25. Classical material  
Reference type 
Section of book 
 
English title: The Winter's Tale: act 5, scene 1, lines 13-16 
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Journal/book/source: The complete works of William Shakespeare 
Date of publication: 1973 
Publisher name: Rex 
City of publication: London 
 
This will be output as:  
The Winter's Tale: act 5, scene 1, lines 13-16. In: The complete works of William Shakespeare. London: Rex, 1973. 
 

26. Conference proceedings which do not use the same style as a journal article 
Reference type 
Conference proceedings 
 
Journal/book/source: Child abuse and neglect: a medical community response. Proceedings of the First AMA National 
Conference on Child Abuse and Neglect; 1984 Mar 30-31; Chicago 
Date of publication: 1985 
Editor(s): Vivian VL 
Publisher name: American Medical Association 
City of publication: Chicago 
 
This will be output as:  
Vivian VL, editor(s). Child abuse and neglect: a medical community response. Proceedings of the First AMA 
National Conference on Child Abuse and Neglect; 1984 Mar 30-31; Chicago. Chicago: American Medical 
Association, 1985. 
 

27. Paper in conference proceedings which do not use the same style as a journal article 
Reference type 
Conference proceedings 
 
Authors: Harley NH 
English title: Comparing radon daughter dosimetric and risk models 
Journal/book/source: Indoor air and human health. Proceedings of the Seventh Life Sciences Symposium; 1984 Oct 
29-31; Knoxville (TN) 
Date of publication: 1985 
Pages: 69-78 
Editor(s): Gammage RB, Kaye SV 
Publisher name: Lewis 
City of publication: Chelsea (MI) 
 
This will be output as:  
Harley NH. Comparing radon daughter dosimetric and risk models. In: Gammage RB, Kaye SV, editor(s). Indoor air 
and human health. Proceedings of the Seventh Life Sciences Symposium; 1984 Oct 29-31; Knoxville (TN). Chelsea 
(MI): Lewis, 1985:69-78. 
 

28. Personal communications 
Reference type 
Correspondence 
 
Authors: Moustgaard R 
Journal/book/source: Personal communication 
Date of publication: December 10 1998 
 
This will be output as:  
Moustgaard R. Personal communication December 10 1998. 
 

29. Computer program 
Reference type 
Computer program 
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English title: Review Manager (RevMan) 
Date of publication: 2002 
Edition: 4.2 for Windows 
Publisher name: The Cochrane Collaboration 
City of publication: Oxford, England 
Medium: CD-ROM and Internet 
 
This will be output as:  
Review Manager (RevMan) [Computer program]. Version 4.2 for Windows. Oxford, England: The Cochrane 
Collaboration, 2002. CD-ROM and Internet. 
 

30. Data on file 
Reference type: 
Unpublished data 
 
Authors: UK/Asia trialists 
English title: Individual patient data (as supplied 1 April 1995) 
Journal/book/source: Data on file 
 
This will be output as: 
UK/Asia trialists. Individual patient data (as supplied 1 April 1995). Data on file. 
 

31. Cochrane Reviews 
Reference type 
Cochrane review 
 
Authors: Silagy C, Mant D, Fowler G, Lancaster T 
English title: Nicotine replacement therapy for smoking cessation (Cochrane Review) 
Journal/book/source: The Cochrane Library 
Date of publication: 1999 
Issue: 1 
Publisher name: Update Software 
City of publication: Oxford 
 
This will be output as:  
Silagy C, Mant D, Fowler G, Lancaster T. Nicotine replacement therapy for smoking cessation (Cochrane Review). 
In: The Cochrane Library, Issue 1, 1999. Oxford: Update Software.  
 

32. Scientific or technical report  
Reference type 
Other 
 
Authors: Akutsu T 
English title: Total heart replacement device 
Journal/book/source: Bethesda (MD): National Institutes of Health, National Heart and Lung Institute; 1974 Apr. 
Report No.: NIH-NHLI-69-2185-4 
 
This will be output as:  
Akutsu T. Total heart replacement device. Bethesda (MD): National Institutes of Health, National Heart and Lung 
Institute; 1974 Apr. Report No.: NIH-NHLI-69-2185-4. 
 

33. Patent  
Reference type 
Other 
 
Authors: Harred JF, Knight AR, McIntyre JS, inventors 
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English title: Dow Chemical Company, assignee. Epoxidation process 
Journal/book/source: US patent 3,654,317. 1972 Apr 4 
 
This will be output as:  
Harred JF, Knight AR, McIntyre JS, inventors. Dow Chemical Company, assignee. Epoxidation process. US patent 
3,654,317. 1972 Apr 4. 
 

34. Newspaper article  
Reference type 
Other 
 
Authors: Rensberger B, Specter B 
English title: CFCs may be destroyed by natural process 
Journal/book/source: The Washington Post 
Date of publication: 1989 Aug 7 
Volume: Sect. A 
Pages: 2 (col. 5) 
 
This will be output as:  
Rensberger B, Specter B. CFCs may be destroyed by natural process. The Washington Post 1989 Aug 7;Sect. A:2 
(col. 5). 
 

35. Audiovisual 
Reference type 
Other 
 
English title: AIDS epidemic: the physician's role [videorecording] 
Journal/book/source: Cleveland (OH): Academy of Medicine of Cleveland, 1987 
 
This will be output as:  
AIDS epidemic: the physician's role [videorecording]. Cleveland (OH): Academy of Medicine of Cleveland, 1987. 
 

36. Legal material  
Reference type 
Other 
 
Journal/book/source: Toxic Substances Control Act: Hearing on S. 776 Before the Subcomm. on the Environment of 
the Senate Comm. on Commerce. 94th Cong., 1st Sess. 343 (1975) 
 
This will be output as:  
Toxic Substances Control Act: Hearing on S. 776 Before the Subcomm. on the Environment of the Senate Comm. on 
Commerce. 94th Cong., 1st Sess. 343 (1975). 
 

37. Map 
Reference type 
Other 
 
English title: Scotland [topographic map] 
Journal/book/source: Washington: National Geographic Society (US) 
Date of publication: 1981 
 
This will be output as:  
Scotland [topographic map]. Washington: National Geographic Society (US) 1981. 
 

38. Unpublished material, in press 
Reference type 
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Other 
 
Authors: Lillywhite HD, Donald JA 
English title: Pulmonary blood flow regulation in an aquatic snake 
Journal/book/source: Science 
Date of publication: in press 
 
This will be output as:  
Lillywhite HD, Donald JA. Pulmonary blood flow regulation in an aquatic snake. Science in press. 
 

39. Publications on the Internet 
Reference type 
Other 
 
Authors: Royal College of Physicians of Edinburgh and UK Cochrane Centre 
English title: Controlled trials from history 
Journal/book/source: www.rcpe.ac.uk/cochrane/ 
Date of publication: (accessed 10 May 2000) 
 
 
This will be output as:  
Royal College of Physicians of Edinburgh and UK Cochrane Centre. Controlled trials from history. 
www.rcpe.ac.uk/cochrane/ (accessed 10 May 2000). 
 

40. Cochrane Reviewers' Handbook 
Reference type  
Other 
 
Authors: Clarke M, Oxman AD, editors  
English title: Cochrane Reviewers' Handbook 4.2 [updated November 2002]  
Journal/book/source: In: The Cochrane Library [database on CDROM]. The Cochrane Collaboration. Oxford: Update 
Software; 2003, issue 1  
 
This will be output as:  
Clarke M, Oxman AD, editors. Cochrane Reviewers' Handbook 4.2 [updated November 2002]. In: The Cochrane 
Library [database on CDROM]. The Cochrane Collaboration. Oxford: Update Software; 2003, issue 1. 
 

41. Section of the Cochrane Reviewers' Handbook 
Reference type  
Other 
 
Authors: Clarke M, Oxman AD, editors  
English title: Formulating the problem. Cochrane Reviewers' Handbook 4.2 [updated November 2002]; Section 4  
Journal/book/source: In: The Cochrane Library [database on disk and CDROM]. The Cochrane Collaboration. 
Oxford: Update Software; 2003, issue 1 
 
This will be output as:  
Clarke M, Oxman AD, editors. Formulating the problem. Cochrane Reviewers' Handbook 4.2 [updated November 
2002]; section 4. In: The Cochrane Library [database on disk and CDROM]. The Cochrane Collaboration. Oxford: 
Update Software; 2003, issue 1. 
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Appendix F: Using reference management software with RevMan 
 

References are transferred between RevMan and reference management software using a file 
format called tagged text format. In general, a tagged text file is a plain text file where each field 
of each reference appears on a separate line. The first characters on each line are the tag 
describing which field the line belongs to. Each reference consists of a group of tagged lines and 
between each reference is a separator. For RevMan tagged text files, the separator is a blank line. 
For a list of the tags used in RevMan, see Appendix G. 

Example of a tagged text file with two references; the first three characters in each line, AU:, TI: 
etc., are the tags: 

AU:You CH, Lee KY, Chey RY, Menguy R 
TI:Electrogastrographic study of patients with unexplained 
nausea, bloating and vomiting 
SO:Gastroenterology  
YR:1980 Aug 
VL:79 
NO:2 
PG:311-4 
RT:Journal article 
 
AU:Colson JH, Armour WJ 
SO:Sports injuries and their treatment 
YR:1986 
EN:2nd 
PB:S. Paul 
CY:London 
RT:Book 

 

References downloaded from databases, e.g. MEDLINE or The Cochrane Library, are usually in 
tagged text format, but there is no standard format. Each database has its own tags and separators 
etc. 

Exporting references from RevMan to reference management software 
First, a tagged text format file containing the references to transfer must be generated. To save the 
references for a review in tagged text format, highlight the review and choose Export/References 
from the File menu. 

Next, the references must be imported into the reference management software. Most reference 
management programs (e.g. ProCite and Reference Manager) has functionality to read tagged text 
files, but since the format varies from database to database it is necessary to have a configuration 
file (in Reference Manager this is called a capture file) for each database. 

RevMan comes with configuration files for ProCite 4 and Reference Manager 8.5 (the files may 
also work in later versions). These files can be found in the RevMan installation directory under 
'Reference management\ProCite' and 'Reference management\RefMan'. 

ProCite 4 instructions: 

The ProCite file is called RevMan4.cfg and it should be copied to the Config directory under the 
ProCite installation directory before use. Next, in ProCite choose Open/File from the menu and 
choose to open the tagged text file containing the references. Choose File type: Tagged, File 
format: RevMan4 and choose a target database for the references. Click the Transfer button. 

Reference Manager 8.5 instructions: 

The Reference Manager file is called RevMan4.cap and it should be copied to the Capture 
directory under the Reference Manager installation directory before use (this directory is called 
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Import in Reference Manager 10). Next, in Reference Manager choose References/Capture from 
the menu (called Import text file in Reference Manager 10). Choose Database: the target database 
for the references, Definition name: RevMan4 and Text file: the tagged text file containing the 
references. Click the Capture button. 

! Because there is not a one to one match between the fields and reference types used in 
RevMan and the reference management software, some information may have to be moved to the 
correct fields after the references are transferred, so please check the references afterwards. 

! Import and export files for EndNote can be found under 'Reference management\EndNote'. 
Instructions on how to use these files can be found in the same directory. 

Importing references from reference management software to RevMan 
RevMan can read references in both tagged text format and Vancouver format. Import of 
Vancouver formatted references only works correctly if the references are in Vancouver journal 
article format. References to books and other types of references are not imported properly. 
Therefore Vancouver format should only be used to transfer references if it is not possible to use 
the tagged text format. 

Files in tagged text format are created from reference management programs by generating a 
bibliography using a special output style and saving it to a plain text file. The output style is 
equivalent to the output styles used to generate bibliographies in other formats (e.g. Vancouver) 
but this special style places each field of each reference on a separate line with the correct tag in 
front of it. 

RevMan comes with output styles for ProCite 4, Reference Manager 8.5, and Endnote (the files 
may also work in later versions). These files can be found in the RevMan installation directory 
under 'Reference management\ProCite', 'Reference management\RefMan', and ‘Reference 
management\Endnote’. 

ProCite 4 instructions: 

The ProCite file is called RevMan4.pos and it should be copied to the Styles directory under the 
ProCite installation directory before use. Next, in ProCite mark the references to transfer. Choose 
File/Print bibliography from the menu. Choose Show: Marked records, Output style: RevMan4. 
Then click Save and choose to save as type Text only. 

Reference Manager 8.5 instructions: 

The Reference Manager file is called RevMan4.os and it should be copied to the Styles directory 
under the Reference Manager installation directory before use. Next, in Reference Manager mark 
the references to transfer. Choose Bibliography/Generate from reference list from the menu. 
Choose References to include: Marked references in list, Output style: RevMan4, Destination: 
File. Then click OK and choose to save as type Text only. 

To import the references from the tagged text file into a review in RevMan, first highlight the 
review and then choose Import/References/Tagged text format from the File menu. The references 
will be imported into the classification pending section under other references. 

! Because there is not a one to one match between the fields and reference types used in 
RevMan and the reference management software, some information may have to be moved to the 
correct fields after the references are transferred, so please check the references afterwards. 

! Import and export files for EndNote can be found under 'Reference management\EndNote'. 
Instructions on how to use these files can be found in the same directory. 
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Appendix G: RevMan discussion list 
A discussion list dealing with RevMan is available on the German Cochrane Centre’s Internet 
server. Through this list, users of RevMan can share their opinions and suggestions for improving 
the program, and ask each other for help in solving problems. 

It is necessary to subscribe to the email list in order to send messages to the list. Messages from 
non-members will be considered as spam and discarded unread. 

Subscribing to the RevMan Discussion List 
To subscribe to the discussion list, use the web interface at: 
http://www.cochrane.de/mailman/listinfo/revman 
Through this page you can also change various settings and view an archive of previous postings 
to the list. 

Removing your name from the RevMan Discussion List 
To remove your name from the discussion list, use the web interface at: 
http://www.cochrane.de/mailman/listinfo/revman 
and click Edit options. 

Sending messages to the RevMan Discussion List 
If you are a member of the list, send a message to everyone on the list by sending an email to: 
revman@cochrane.de 

 

http://www.cochrane.de/mailman/listinfo/revman
http://www.cochrane.de/mailman/listinfo/revman
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Appendix H: Special characters supported in Cochrane reviews 
 
! Character examples in the table may vary on different systems, use the descriptions for confirmation. If 
the example in this table does not display correctly on your system, do not use that character. 
 

Characters from the Arial font 

These can, for example, be inserted using non-English keyboards, using Insert symbol or using Windows' 
character map. 
 
Ex.  Description Ex.  Description 

¡  Inverted exclamation mark Ñ  Latin capital letter n with tilde 
¢  Cent sign Ò  Latin capital letter o with grave accent 
£  Pound sign Ó  Latin capital letter o with acute accent 
¤  Currency sign Ô  Latin capital letter o with circumflex accent 
¥  Yen sign Õ  Latin capital letter o with tilde 
¦  Broken bar Ö  Latin capital letter o with diaeresis 
§  Section sign ×  Multiplication sign 
¨  Diaeresis Ø  Latin capital letter o with stroke 
©  Copyright sign Ù  Latin capital letter u with grave accent 
ª  Feminine ordinal indicator Ú  Latin capital letter u with acute accent 
«  Left-pointing double angle quotation mark Û  Latin capital letter u with circumflex accent 
¬  Not sign Ü  Latin capital letter u with diaeresis 
-  Soft hyphen Ý  Latin capital letter y with acute accent 
®  Registered sign Þ  Latin capital letter thorn 
¯  Macron ß  Latin small letter sharp s 
°  Degree sign à  Latin small letter a with grave accent 
±  Plus-minus sign á  Latin small letter a with acute accent 
²  Superscript two â  Latin small letter a with circumflex accent 
³  Superscript three ã  Latin small letter a with tilde 
´  Acute accent ä  Latin small letter a with diaeresis 
µ  Micro sign å  Latin small letter a with ring above 
¶  Pilcrow sign æ  Latin small ligature ae 
·  Middle dot ç  Latin small letter c with cedilla 
¸  Cedilla è  Latin small letter e with grave accent 
¹  Superscript one é  Latin small letter e with acute accent 
º  Masculine ordinal indicator ê  Latin small letter e with circumflex accent 
»  Right-pointing double angle quotation mark ë  Latin small letter e with diaeresis 
¼  Vulgar fraction one quarter ì  Latin small letter i with grave accent 
½  Vulgar fraction one half í  Latin small letter i with acute accent 
¾  Vulgar fraction three quarters î  Latin small letter i with circumflex accent 
¿  Inverted question mark ï  Latin small letter i with diaeresis 
À  Latin capital letter a with grave accent ð  Latin small letter eth 
Á  Latin capital letter a with acute accent ñ  Latin small letter n with tilde 
Â  Latin capital letter a with circumflex accent ò  Latin small letter o with grave accent 
Ã  Latin capital letter a with tilde ó  Latin small letter o with acute accent 
Ä  Latin capital letter a with diaeresis ô  Latin small letter o with circumflex accent 
Å  Latin capital letter a with ring above õ  Latin small letter o with tilde 
Æ  Latin capital ligature ae ö  Latin small letter o with diaeresis 
Ç  Latin capital letter c with cedilla ÷  Division sign 
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È  Latin capital letter e with grave accent ø  Latin small letter o with oblique bar 
É  Latin capital letter e with acute accent ù  Latin small letter u with grave accent 
Ê  Latin capital letter e with circumflex accent ú  Latin small letter u with acute accent 
Ë  Latin capital letter e with diaeresis û  Latin small letter u with circumflex accent 
Ì  Latin capital letter i with grave accent ü  Latin small letter u with diaeresis 
Í  Latin capital letter i with acute accent ý  Latin small letter y with acute accent 
Î  Latin capital letter i with circumflex accent þ  Latin small letter thorn 
Ï  Latin capital letter i with diaeresis ÿ  Latin small letter y with diaeresis 
Ð  Latin capital letter eth   

 

Characters from the Symbol font 

These can be inserted using the Insert symbol button on the Text of review screen. They are only supported 
in the main text of review. 
 
Ex. Description Ex. Description 
± Plus minus ℵ Alef symbol 
× Multiply ℑ I fraktur 
÷ Divide ℜ R fraktur 
 Registered (serif) ℘ Weierstrass 
 Copyright (serif)  Trade mark (serif) 
¬ Not  Trade mark (sans serif) 
 Registered (sans serif) ↔ Arrow left and right 
 Copyright (sans serif) ← Arrow left 
ƒ Florin or Guilder ↑ Arrow up 
Α Capital Alpha → Arrow right 
Β Capital Beta ↓ Arrow down 
Γ Capital Gamma ↵ Carriage return 
∆ Capital Delta ⇔ Double arrow left and right 
Ε Capital Epsilon ⇐ Double arrow left (implied by) 
Ζ Capital Zeta ⇑ Double arrow up 
Η Capital Eta ⇒ Double arrow right (implies) 
Θ Capital Theta ⇓ Double arrow down 
Ι Capital Iota ∀ For all 
Κ Capital Kappa ∃ There exists 
Λ Capital Lambda ∋ Such that, small contains as member 
Μ Capital Mu ∗ Asterisk operator 
Ν Capital Nu − Minus (- is hyphen) 
Ξ Capital Xi ≅ Approximately equal to, congruent 
Ο Capital Omicron ∴ Therefore 
Π Capital Pi ⊥ Perpendicular 
Ρ Capital Rho ∼ Similar, tilde operator  
Σ Capital Sigma ≤ Less than or equal to 
Τ Capital Tau ∞ Infinity 
Υ Capital Upsilon ≥ Greater than or equal to 
Φ Capital Phi ∝ Proportional 
Χ Capital Chi ∂ Partial derivative / partial differential 
Ψ Capital Psi • Bullet operator 
Ω Capital Omega ≠ Not equal 
α Lower case alpha ≡ Equivalent 
β Lower case beta ≈ Almost equal to, asymptotic to 
γ Lower case gamma ⊗ Circle multiply 
δ Lower case delta ⊕ Circle plus 
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ε Lower case epsilon ∅ Empty set 
ζ Lower case zeta ∩ Intersection 
η Lower case eta ∪ Union 
θ Lower case theta ⊃ Proper superset, superset of 
ι Lower case iota ⊇ Reflex superset, superset of or equal to 
κ Lower case kappa ⊄ Not subset 
λ Lower case lambda ⊂ Proper subset, subset of 
µ Lower case mu ⊆ Reflex subset, subset of or equal to 
ν Lower case nu ∈ Member (element) 
ξ Lower case xi ∉ Not a member (not an element) 
ο Lower case omicron ∠ Angle 
π Lower case pi ∇ Nabla or gradient 
ρ Lower case rho ∏ Product of 
ς Lower case sigma (terminal) √ Square root 
σ Lower case sigma ⋅ Dot operator 
τ Lower case tau ∧ Logical and 
υ Lower case upsilon ∨ Logical or 
φ Lower case phi ∑ Sum of 
χ Lower case chi ∫ Integral 
ψ Lower case psi 〈 Left angle bracket (< is less than) 
ω Lower case omega 〉 Right angle bracket (> is greater than) 
ϑ Theta symbol ◊ Lozenge 
ϕ Phi symbol ♣ Clubs 
ϖ Pi symbol ♦ Diamonds 
ϒ Upsilon with hook symbol ♥ Hearts 
′ Prime or minutes or feet ♠ Spades 
⁄ Figure slash (fraction) (/ is normal slash)   
″ Double prime or seconds or inches   
… Ellipsis   
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Appendix I: Statistical methods used in RevMan Analyses 
 
Data structure 
 
Consider a meta-analysis of k studies. When the studies have a binary outcome the results of each study can 
be presented in a 2x2 table (Table 1) giving the numbers of subjects who do or do not experience the event 
in each of the two groups (here called intervention and control). 
 
Table 1 Binary data 
Study i  Event No event Total 
Intervention ia  ib  in1  

Control ic  id  in2  
 
 
If the outcome is a continuous measure, the number of subjects in each of the two groups, their mean 
response and the standard deviation of their responses are required to perform meta-analysis (Table 2). 
 
Table 2 Continuous data 
Study i  Group size Mean response Standard deviation 
Intervention in1  im1  isd1  

Control in2  im2  isd 2  
 
 
Formulae 
 
Individual Study Responses: Binary outcomes 
 
For study i denote the cell counts as in Table 1, and let iii ban +=1 , iii dcn +=2 , and iii nnN 21 += . For 

the Peto method the individual odds ratios are given by 

}/])[exp{(ˆ
iiii vaEaRO −=  

with its logarithm having standard error 

ii vROse /1)}ˆ{ln( =  

where iiiii NcanaE /)(][ 1 +=  (the expected number of events in the intervention group) and 

)]1(/[)])(([ 2
21 −++= iiiiiiiii NNdbcannv  (the hypergeometric variance of ia ). 

For other methods of combining trials, the odds ratio for each study is given by 

iiiii cbdaRO /ˆ =  

the standard error of the log odds ratio being 

iiiii dcbaROse /1/1/1/1)}ˆ{ln( +++=  

The risk ratio for each study is given by 

)//()/(ˆ
21 iiiii ncnaRR =  

the standard error of the log risk ratio being 
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iiiii nncaRRse 21 /1/1/1/1)}ˆ{ln( −−+=  

The risk difference for each study is given by 

)/()/(ˆ
21 iiiii ncnaDR −=  with standard error 3

2
3
1 //)ˆ( iiiiiii ndcnbaDRse +=  

Where zero cells cause problems with computation of effects or standard errors, 0.5 is added to all cells 

( ia , ib , ic , id ) for that study, except when 0== ii ca  or 0== ii db , where the relative effect measures 

iRÔ  and iRR̂  are undefined. 

 
Individual Study Responses: Continuous outcomes 
 
Denote the number of subjects, mean and standard deviation as in Table 2, and let 

iii nnN 21 +=  

and 

)2/())1()1(( 2
22

2
11 −−+−= iiiiii Nsdnsdns  

be the pooled standard deviation of the two groups. The weighted mean difference is given by 

ii mmDMW 21
ˆ −=  with standard error iiii nsdnsdDMWse 2

2
21

2
1 //)ˆ( +=  

There are several popular formulations of the standardised mean difference. The one implemented in 

RevMan Analyses is Hedges adjusted g, which is very similar to Cohen's d, but includes an adjustment for 

small sample bias 

))94/(31)(/)((ˆ 21 −−−= iiiii Nsmmg  with standard error 

))94.3(2/(ˆ)/()ˆ( 2
21 −+= iiiiii NgnnNgse . 

 
Pooling Methods 
 
Mantel-Haenszel Methods for Combining Trials 
 
For each study, the effect size from each trial iΘ̂  is given weight iw  in the analysis. The overall estimate 

of the pooled effect, MHΘ̂  is given by 

∑
∑ Θ

=Θ
i

ii
MH w

w ˆ
ˆ  

 

For combining odds ratios, each study's OR  is given weight 

iiii Ncbw /= , 

and the logarithm of MHRÔ  has standard error given by 
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2/)/)())/()((/)(()}ˆ{ln( 22 SQSSRQRPSRPRROse MH +×++=  

where 

∑= iii NdaR / ; ∑= iii NcbS / ; 

∑ += 2/)( iiiii NdadaPR ; ∑ += 2/)( iiiii NcbdaPS ; 

∑ += 2/)( iiiii NdacbQR ; ∑ += 2/)( iiiii NcbcbQS  

 

For combining risk ratios, each study's RR  is given weight 

iiiii Nbacw /)]([ += , 

and the logarithm of MHRR̂  has standard error given by 

)/()}ˆ{ln( SRPRRse MH ×=  

where 

∑ −+= 2
21 /))(( iiiiiiii NNcacannP ; ∑= iii NnaR /2 ; ∑= iii NncS /1  

For risk differences, each study's RD  has the weight 

iiii Nnnw /21=  

and MHDR̂  has standard error given by 

)/(}ˆ{ 2QPDRse MH =  

where 

∑ += )/()( 2
21

3
1

3
2 iiiiiiiii NnnndcnbaP ; ∑= iii NnnQ /21  

 

The heterogeneity statistic is given by 
2)ˆˆ( MHiiwQ Θ−Θ′= ∑  

where Θ̂  is the log odds ratio, log relative risk or risk difference and the iw′  are the weights calculated as 

2)ˆ(/1 ise Θ . Under the null hypothesis that there are no differences in treatment effect between trials this 

follows a chi-squared distribution on 1−k  degrees of freedom (where k  is the number of studies 

contributing to the meta-analysis). 

 

The statistic 2I  is calculated as 

%100)1(2 ×
−−

=
Q
kQI  

This measures the extent of inconsistency among the studies' results, and is interpreted as approximately the 
proportion of total variation in study estimates that is due to heterogeneity rather than sampling error. 
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Inverse Variance Methods for Combining Trials 
 
Inverse variance methods are used to pool both standardised mean differences, and weighted mean 

differences for continuous data. In the general formula the effect size is defined to be iΘ̂  which is the trials 

SMD  or WMD . The individual effect sizes are weighted according to the reciprocal of their variance 

(calculated as the square of the standard error given in the individual study section above) giving 
2)ˆ(/1 ii sew Θ=  

These are combined to give a pooled estimate 

∑
∑ Θ

=Θ
i

ii
IV w

w ˆ
ˆ  

with 

∑=Θ iIV wse /1}ˆ{  

The heterogeneity statistic is given by a similar formula as for the Mantel-Haenszel method, using the 

inverse variance form of the weights, iw  

∑ Θ−Θ= 2)ˆˆ( IViiwQ . 

2I  is calculated as above. 
 
Peto's Assumption Free Method for Combining Trials 
 
Here, the overall odds ratio is given by 

∑ ∑= }/)ˆln(exp{ˆ
iiiPeto wROwRO , 

where the odds ratio iRÔ  is calculated using the approximate method described in the individual trial 

section, and the weights, iw  are equal to the hypergeometric variances, iv . 

 

The logarithm of the odds ratio has standard error 

∑= iPeto vROse /1)}ˆ{ln(  

The heterogeneity statistic is given by 

∑ −= })ˆ(ln)ˆ{(ln 22
Petoii ROROvQ . 

2I  is calculated as above. 
 
DerSimonian and Laird Random Effects Models 
 
Under the random effects model, the assumption of a common treatment effect is relaxed, and the effect 

sizes are assumed to have a distribution 

),( 2τΘ≈Θ Ni . 
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The estimate of 2τ  is given by 

∑ ∑ ∑−−−= }0],/))((/[)]1(max{[ˆ 22
iii wwwkQτ , where the iw  are the inverse variance weights 

(calculated as 2)ˆ(/1 ise Θ ) for log OR, log RR, RD, WMD and SMD, as appropriate. 

The estimate of the combined effect for the heterogeneity may be taken as either the Mantel-Haenszel or the 

inverse variance estimate. Again, for odds ratios and risk ratios, the effect size is taken as the natural 

logarithm of the OR and RR. Each study's effect size is given weight 

)ˆ)ˆ(/(1 22 τ+Θ=′ ii sew  

The pooled effect size is given by 

∑ ∑ ′Θ′=Θ )/()ˆ(ˆ
iiiDL ww  

and 

∑ ′=Θ iDL wse /1}ˆ{  

Note that in the case where the heterogeneity statistic Q  is less than or equal to its degrees of freedom 

)1( −k , the estimate of the between trial variation, 2τ̂ , is zero, and the weights reduce to the those as given 

by the inverse variance method. 

 
Confidence intervals 
 
The )%1(100 α−  confidence interval for Θ̂  is given by 

)2/1()ˆ(ˆ α−ΦΘ−Θ se , to )2/1()ˆ(ˆ α−ΦΘ+Θ se  

where Θ̂  is the log odds ratio, log relative risk, risk difference, mean difference or standardised mean 

difference, and Φ  is the standard normal deviate. 

 
Test statistics 
 
In all cases, the test statistic is given by 

)ˆ(/ˆ ΘΘ= sez  

where the odds ratio or risk ratio is again considered on the log scale. 

 
Bibliography 
 
Breslow NE, Day NE. Combination of results from a series of 2x2 tables; control of confounding. In: 
Statistical Methods in Cancer Research, Volume 1: The analysis of case-control data. IARC Scientific 
Publications No.32. Lyon: International Agency for Health Research on Cancer, 1980. 
 
Deeks JJ, Altman DG, Bradburn MJ. Statistical methods for examining heterogeneity and combining results 
from several studies in a meta-analysis. In: Egger M, Davey Smith G, Altman DG, editors. Systematic 
Reviews and Healthcare: meta-analysis in context. London: BMJ Publications, 2002:285-312. 
 



RevMan 4.2 User Guide 

87 

DerSimonian R, Laird N. Meta-analysis in clinical trials. Controlled Clinical Trials 1986;7:177-188. 
 
Greenland S, Robins J. Estimation of a common effect parameter from sparse follow-up data. Biometrics 
1985;41:55-68. 
 
Greenland S, Salvan A. Bias in the one-step method for pooling study results. Statistics in Medicine 
1990;9:247-252. 
 
Hedges LV, Olkin I. Statistical Methods for Meta-analysis. San Diego: Academic Press, 1985: Chapter 5. 
 
Higgins JPT, Thompson SG. Quantifying heterogeneity in a meta-analysis. Statistics in Medicine 2002; 21: 
1539-1558 
 
Mantel N, Haenszel W. Statistical aspects of the analysis of data from retrospective studies of disease. 
Journal of the National Cancer Institute 1959;22:719-748. 
 
Robins J, Greenland S, Breslow NE. A general estimator for the variance of the Mantel-Haenszel odds 
ratio. American Journal of Epidemiology 1986;124:719-723. 
 
Rosenthal R. Parametric measures of effect size. In: Cooper H, Hedges LV, editors. The Handbook of 
Research Synthesis. New York: Russell Sage Foundation, 1994. 
 
Sinclair JC, Bracken MB. Effective Care of the Newborn infant. Oxford: Oxford University Press, 
1992:Chapter 2. 
 
Yusuf S, Peto R, Lewis J, Collins R, Sleight P. Beta blockade during and after myocardial infarction: an 
overview of the randomized trials. Progress in Cardiovascular Diseases 1985;27:335-371. 



RevMan 4.2 User Guide 

88 

Appendix J: Validation rules 
Two kinds of validation rules exist: Rules that result in error messages (marked E in the table below) and 
rules that result in warnings (marked W in the table below). Errors must be corrected to ensure that a review 
is published in its present form. Warnings are non-critical but serve as guidelines for complying with the 
correct format of Cochrane reviews. Some rules apply to protocols only (P), some apply to reviews only 
(R), and some apply to both reviews and protocols (P+R). 
 
Table of validation rules 
 
Abbreviations used: P: Protocol, R: Full review, E: Error, W: Warning 
 

Condition Applies 
to 

Error 
type 

- Title is empty P+R E 
- List of reviewers for citation is empty P+R E 
- First name and last name of contact reviewer are empty P+R E 
- First name or last name of contact reviewer is empty P+R W 
- All the address lines 'department', 'organisation', 'street 1', and 'street 2' of contact 
reviewer are empty 

P+R E 

- City of contact reviewer is empty P+R E 
- Country of contact reviewer is empty P+R E 
- Date of last substantive update is empty R E 
- Contribution of reviewers is empty P+R W 
- Issue review is expected to be published is empty P E 
- Review/protocol is withdrawn but no explanation has been given P+R W 
- Section ‘Synopsis’ is empty R W 
- Section ‘Abstract: Background’ is empty R E 
- Section ‘Abstract: Objectives’ is empty R E 
- Section ‘Abstract: Search strategy’ is empty R E 
- Section ‘Abstract: Data collection and analysis’ is empty R E 
- Section ‘Abstract: Main results’ is empty R E 
- Section ‘Abstract: Reviewers’ conclusions’ is empty R E 
- Section ‘Background’ is empty P+R E 
- Section ‘Objectives’ is empty P+R E 
- Section ‘Types of studies’ is empty P+R E 
- Section ‘Types of participants’ is empty P+R E 
- Section ‘Types of intervention’ is empty P+R E 
- Section ‘Types of outcome measures’ is empty P+R E 
- Section ‘Search strategy for identification of studies’ is empty P+R E 
- Section ‘Methods of the review’ is empty P+R E 
- Section ‘Description of studies’ is empty R E 
- Section ‘Methodological quality’ is empty R E 
- Section ‘Results’ is empty R E 
- Section ‘Discussion’ is empty R E 
- Section ‘Implications for practice’ is empty R E 
- Section ‘Implications for research’ is empty R E 
- Section ‘Acknowledgements is empty R W 
- Section ‘Potential conflict of interest’ is empty P+R E 
- One or more rows in the table of included studies are empty R W 
- One or more rows in the table of excluded studies are empty R W 
- One or more headings in additional table XX are empty P+R W 
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- One or more headings in other data table XX.YY.ZZ are empty R W 
- Included study X does not have any references R W 
- Excluded study X does not have any references R W 
- Study X has an empty reference R W 
- Reference X is empty P+R W 
- Reference type Journal article missing: AU, TI, SO, YR, VL, or PG P+R W 
- Reference type Book missing: AU, TI, SO, YR, or PB P+R W 
- Reference type Section of book missing: AU, SO, TI, YR, or PB P+R W 
- Reference type Conference proceedings missing: AU, SO, or YR P+R W 
- Reference type Correspondence missing: AU, SO, or YR P+R W 
- Reference type Computer program missing: TI, YR, PB P+R W 
- Reference type Unpublished data missing: AU, TI, or SO P+R W 
- Reference type Cochrane review missing: AU, TI, SO, YR, NO, PB or CY P+R W 
- Reference type Other missing: TI or SO P+R W 
- No link in the text to an Additional reference P+R W 
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Appendix K: Checklist for using additional figures 
This checklist should be used by reviewers and review groups to ensure that the basic requirements for 
additional figures in Cochrane Reviews are met. Images that do not meet these requirements will not be 
accepted for publication. For more information, see section 14.2. 
 

# 1. Is an additional figure necessary? 
If the figure content can be represented in other ways in RevMan (Analyses graphs, Additional 
tables), please use that route, not an Additional Figure. 

# 2. Is the additional figure a graph? 
If the additional figure is a graph, the graph must comply with the guidelines in Appendix 8a in 
the Reviewers’ Handbook. 

# 3. Cropping 
All white space on all sides (and any part of the image not required) should be removed. Captions 
should not be included in the image, but any key or legend should remain in the image 

 ! In RevMan, use Fit to screen to see the entire image and check the cropping.   

# 4. Scaling 
Scale image down to smallest size consistent with readability.  Ensure final dimensions do not 
exceed 800 pixels wide by 1000 pixels high. 

# 5. Colour Depth 
Choose appropriate colour depth:  
- for graphs, charts or tables: 1, 4 or 8 bits per pixel 
- for black and white photos:  8 Bits per pixel 
- for colour photos: 24 bits per pixel 

# 6. File Format 
Save in correct format (JPEG for naturalistic photographs such as anatomy or histology slides 
and PNG for diagrammatic subjects such as graphs, flowcharts or tables). 

 ! In RevMan, use Image info to check size, colour depth and file format.  

# 7. Assess quality 
Look at the image both on screen and in print – is it suitable for a professional publication? Is all 
text legible and lines unbroken and clear? Is anything too soft (blurry) or too crisp (e.g. ‘circles’ 
that are jagged, not round). 

# 8. Copyright 
Reviewers must have obtained permission and hold originals of any permission requests for any 
images that are already protected by copyright; this is a legal requirement. 

# 9. Caption 
Ensure Caption text for each figure is typed into the RevMan "Caption" field. If permission to 
publish a copyrighted figure is granted, the final phrase of the figure caption must be: “Copyright 
© [Year] [Name of copyright holder, or other required wording]: reproduced with permission.” 

# 10. Cross References 
Ensure each figure is linked to from the text of the review at least once. Otherwise, it will not 
display in the published version. 

# 11. Tidy up 
Delete any figures that were added in RevMan but that you have decided not to use, and 
renumber/rename others as appropriate to keep an unbroken sequence of Additional Figures, i.e. 
Figure 01, Figure 02, etc. 
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